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Conventions

Boldface
Capitalization

Computer font

Italics

{3

Words in boldface type represent programs and commands.
Capitalized first letters represent company or product names.

Words in computer font represent file or path names,
command syntax statements, prompts or messages that appear
on your screen, or text you should type on your workstation or
terminal.

Words in italics represent variables in syntax statements
or words that are emphasized in the text.

Represents required elements in a syntax statement.
When several elements are separated by the | symbol,
you must select one of the elements.

Represents optional elements in a syntax statement.
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Chapter 1: Exchange SPI Concepts
Introduction

Introduction

This chapter introduces the basic concepts of the HP OpenView Smart Plug-in

for Microsoft® Exchange Server (Exchange SPI), version A.08.10, which works
together with HP OpenView Operations for UNIX versions 7.x and 8.x, to
monitor Microsoft Exchange 5.5, 2000 and 2003.

The chapter includes the following sections:

O What the Exchange SPI does
O How the Exchange SPI works
Q Exchange organization
O Exchange SPI components:

®  Exchange SPI Service Discovery
Exchange SPI Service Maps
Exchange SPI Template groups and Templates
Exchange SPI Application groups and Applications
Exchange SPI Message groups and Messages
Exchange SPI Reports and Graphs
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What the Exchange SPI does

The Exchange SPI adds Exchange 5.5, 2000 and 2003 server-monitoring
capabilities to HP OpenView Operations for UNIX, allowing you to oversee
your distributed Exchange environment from a central, easy-to-use console. In
so doing, you can:

B Increase Exchange availability and performance
B Lower support costs associated with the Exchange service
B Improve capacity management and planning for Exchange

With the Exchange SPI integrated into the OVO console, you can apply the HP
OpenView performance and problem management processes that you use for
networks and systems to monitor MS Exchange.

After setup, the Exchange SPI will monitor critical Exchange
application/database resources including:

B Processes (for monitoring the amount of CPU time being used by core
Exchange processes)

B [nactive Processes (for monitoring core MS Exchange processes for activity
and status)

m Exchange Services (for monitoring Exchange Server processes for activity
levels)

B Message Transfer Agent (MTA) and Simple Mail Transfer Protocol (SMTP)
message process data

B MTA Work Queue and SMTP Queues
B[S Public and Private/Mailbox Average Delivery Time

B Cluster environments.

Information comes to you in the OpenView Operations console through service
maps, messages, alerts, reports and graphs.
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How the Exchange SPI works

Like other Smart Plug-ins, the Exchange SPI collects data that is targeted and
gathered according to rules and schedule specifications contained within the
Exchange SPI templates.

HOW DATA COLLECTION OCCURS

When the collection’s scheduled time occurs, the Exchange SPI
collector/analyzer program is executed and if required, forwards metric values to
OVO and the HP data collecting agent. At the same time, OVO checks against
predefined threshold settings and triggers alarms when violations occur.

WHERE DATA IS STORED

The collected data is written to a log file residing on the managed node, at
pre-defined intervals.

HOW DATA IS DISPLAYED

Messages appear in the OVO Message Browser with message details containing
instruction text to help diagnose and remedy problems. If PerfView is present,
metric values are available as graphs and if Reporter is installed, reports are
available.
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Exchange organization

The Exchange organization in an enterprise can be extremely complex, the diagram
below might help in keeping an overview:

Administratve Groups
| |

| Routing Groups | sites |

Hierarchical View of
Exchange Topology OQueues

* Exchange 2000 on by ; -
B Exchange 5.5 anly —| Instant Messaning Server |
Exchange 20002003 only “Conferencing Server |

M Exchange 5.5.2000/2003
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Exchange SPI components

The following components appear in the OpenView for UNIX GUI when
Exchange SPI is installed:

Exchange SPI Service Discovery

Exchange SPI Service Maps

Exchange SPI Template groups and Templates
Exchange SPI Application groups and Applications
Exchange SPI Message groups and Messages
Exchange SPI Reports and Graphs

AN

1. EXCHANGE SPI SERVICE DISCOVERY

The Exchange SPI discovers Exchange services on OVO managed nodes.
Exchange Service Discovery requires the OVO Service Navigator, which can be
installed on the management server with other components when OVO is
installed initially, or installed alone at a later date. Please refer to the OVO
Installation Guide for more details.

See the section Exchange SPI Service Discovery chapter 4 page 93 for more
information on the Service Discovery process.

2. EXCHANGE SPI SERVICE MAPS

The service graph generated by the Exchange SPI Service Discovery application
is a snapshot of the Exchange services on the managed nodes at the time at
which the application is run. The discovered Exchange topology is maintained in
OVO and dynamic views are available of their current state in the service maps
and views.
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Example Service Map

'7 Service Graph [Services]

Microsoft Exchange Ser... |

Microsoft Exchange 2EIEIEI| hlicrosoft Exchange 5.5 |

e

Organization: First Orga...

B

Administrative Group: F...

—

5?"‘._ _J
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3. EXCHANGE SPI TEMPLATE GROUPS AND TEMPLATES

Templates

NOTE: In OVOU 8, templates are referred as policies.

Templates measure collected data against predefined rules, generating alarms
and messages to assist in problem analysis and resolution. Corrective actions are
suggested in help text available in the message details.




NOTE:
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Templates can be distributed as groups or individually. For a complete listing of
templates, see Appendix B, beginning on page 189.

Template groups

The Exchange Service Discovery group contains templates for the service
discovery procedure. The EXSPI Quick Start template group contains
templates that are easy to install and distribute and require no special
customization. Many templates in the EXSPI Add-Ons and EXSPI Advanced
template groups require a more advanced configuration procedure. Before
getting started, review template requirements in Exspi Template Group
Requirements chapter 4 page 89.

Template types
Within the Exchange group are:

B Schedule templates that determine when and what metrics are
collected

B Monitor templates that implement the actual metric condition
(threshold, object, message text, instructions, etc.)

B Message templates that intercept the Exchange SPI messages

®  Logfile encapsulator templates that monitor for Exchange server
related messages in the Windows event log, and send them to the OVO
Message browser.

For information on customizing template settings, see Basic Customization
chapter 7 page 150.

This version of the Exchange SPI monitors MS Exchange 2003, 2000 and 5.5.
Template and Template group names contain the version number in the prefix:
65 refers to Exchange 2003 only, 60 refers to Exchange 2000 and 2003, and 55
to Exchange 5.5 only. For example, where an Exchange 5.5 template group has
the name EXSPI-55 Event Log Errors, the equivalent Exchange 2000 and
2003 template groupis EXSPI-60 EventLog Errors.
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In this guide, templates/template groups relevant to all Exchange versions are
referred as EXSPI-55/60 <template name>.

4. EXCHANGE SPI APPLICATION GROUPS AND
APPLICATIONS

The Exchange SPI applications are available in the OVO Application Bank
under the application group, EXSPI Admin, which contains the Exchange 2000
and 2003, and Exchange 5.5 application groups.

EXSPI Admin application group in the Application Bank window.

1 VP Apphcation Bark

R

4] |
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The Exchange SPI makes available the following applications in the Application
Group for each version of Exchange:

EXSPI Add DataSource: Exchange SPI application to configure data
sources and start the logging of data.

Disable Data Logging: Stops Exchange SPI from logging data.

Enable Data Logging: Starts Exchange SPI data logging, the default
setting is ON. This is normally used after Disable Data Logging, to
restart data logging.

EXSPI Discovery: 1f the OpenView Service Navigator software is

installed and running, the EXSPI Discovery application generates a
snap shot graph of the Exchange services on all the OVO managed
nodes at the time it runs.

Enable Message Tracking (for Exchange 2000 and 2003 only): Turning
message tracking on will cause the Exchange server to write tracking
log files. The Exchange SPI track log schedule template parses these
log files to collect data for the four tracklog reports: Exchange Top
Destinations, Exchange Top Recipients, Exchange Top Senders, and
Exchange Top Sources.

EXSPI Graphs: Contains graphs that can be generated from selected
metric monitors.

EXSPI MBOX Config: Starts the mailbox configuration program that
automatically creates a mailbox.

B For Exchange 5.5: the mailbox is created with service account as
the owner, so the service account must be created prior to running
the application, see Creating a Service Account with Proper Access
Permissions chapter 2 page 22.

B The script supports two options. The syntax is:
exspi e2k cfg [-m mailBoxName] [ -ou OU ]
-m (optional parameter) is the mailBoxName prefix.
-ou (optional parameter) is the Organizational Unit.
If the -m parameter is not specified, the default prefix is MSXSPI.
The mailbox enabled service account is created as
MSXSPI<hostname>. This mailbox name is added to the
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exsllfi\defaults file as line MATLBOX mailBoxName.
If the -ou parameter is not specified, the mailbox will be created in
the USERS container.

B By default a mailbox named MSXSPI<hostname> is created on the
Exchange server where "hostname " is the name of the Exchange
server.

B  The mailbox is created hidden from the GAL.

EXSPI Node Config: Configures the service account with special
Exchange privileges (MSXSPI) on the managed node. This account is
for templates distributed in the Advanced Configuration section.

EXSPI Ping Config: Configures the Advanced Configuration
Template: End To End Message Ping.

Enable EXSPI Tracing: Enables tracing; default setting is OFF. This
application is generally used for troubleshooting. When tracing is
turned on the results are written to:
$OvAgentDir%\exspi\log\trace.

Disable EXSPI Tracing: Disables tracing; default setting is OFF

Exchange Cluster Config: The Exchange Cluster Config application
prints apminfo data, which can be used to create the apminfo.xml file
used by the Exchange SPI to recognize clustered instances. For further
information about Exchange SPI monitoring clusters, see Using
Exchange SPI in high availability environments chapter 5 page 108.
Regarding privileges: This application can be run as any account that
has the ability to read wmi, such as a Domain admin or an Exchange
admin account

Mount Exchange DB: This application can search for and mount
dismounted mailboxes or public folder store databases. It requires
the user name and password of a special account that has
Exchange administrative privileges, as the application must be
modified with this info before executing, see Creating a Service
Account with Proper Access Permissions chapter 2 page 22.

The application can take one or all of the following parameters:
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-s Search for dismounted databases.

-m Search for dismounted databases and attempt to mount any
found.

-p Print the output.
-a Forward an alarm message to the OVO Management server.

-t Timeout: the time the tool can take to re-mount a dismounted
database (in seconds). If not provided, the script will automatically
set the timeout value to be 5 seconds. If the database cannot be
remounted within the time frame given, you can set a higher
timeout value, e.g. 30 seconds. If remounting the dismounted
database still fails, and there is not an error in the output of the tool,
there is probably a problem with the Exchange information store
service.

Exchange 5.5 Exchange SPI Applications.

¥ Applcation Group: Exchange 55
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Enadls EXSH Trai
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Exchange 2000 and 2003 Exchange SPI Applications

X Application Group: Exchange 2000 and 2003
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5. EXCHANGE SPI MESSAGE GROUPS AND MESSAGES

OVO Message Group Bank window

There are three Exchange SPI message groups located in the OVO Message
Group Bank window and all messages generated by the Exchange SPI fall into
one of these message groups. They are:

1. EXSPI: contains messages generated by Exchange-SPI programs. They
contain instruction text to help to diagnose/remedy problems.

2. EX_Perf: contains messages regarding Exchange performance.
3. EX Fault: contains messages regarding error conditions.

Exchange SPI messages are associated with services in the service map.
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6. EXCHANGE SPI REPORTS AND GRAPHS
Exchange SPI Reports

Exchange SPI reports come in a separate package, EXSPI-Reporter.msi which
can be found in the HP OpenView Operations for Unix Application CD-ROM.
HP OV Reporter can be used to access the Exchange SPI data source,

EXSPI DATA present on the managed node and generate reports using Seagate
Crystal Reports. These reports are broadly classified as Summary and Detail
reports.

B Summary reports show data for all servers.

B Detail reports show information by system. See Reports for Exchange
2000 and 2003 chapter 6 page 134, and Reports for Exchange 5.5 only
chapter 6 page 137, for complete lists of out-of-the-box Exchange SPI
reports.

Exchange SPI Graphs

Exchange SPI includes a set of preconfigured graphs that can be viewed in HP
Perfview. PerfView graphs require that an OpenView Performance Agent (also
known as MeasureWare Agent) is running on the managed node. Upon
installation of Exchange SPI, these graphs are located in the Application Bank
under: EXSPI Admin > Exchange [2000 and 2003/55] > Exchange [2000 and
2003/55] Graphs.

The graphs are categorized as: Information Store, Messaging, System
Information and Transaction Log File Size (Exchange 5.5 only). For more
information, see Exchange SPI Graphs chapter 6 page 141.

In addition, data from any Exchange SPI server can be graphed using PerfView
and data from the Exchange SPI OVO data collecting agent DSI logfiles. For
more information, see Generating Graphs from an Exchange SPI DSI Logfile
chapter 6 page 145.
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PerfView Graph Generated from Exchange SPI Data

File Show Settings
User Connections (Points Every 3 hrs

_| FC-MOE:EXSPI:Single Instances:IS Active User Count
_| FC-MOE:EXSPI:Single Instances:IS User Count

00:00 00:00 00:00 00:00 00:00 00:00 00:00 15:00
05115199 051699 05117199 0518199 05/19/99 05/20/99 05/21/99
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Introduction

The Exchange SPI collects data from many sources. In order to collect the many
types of data, the Exchange SPI requires advanced user credentials.

This chapter outlines:

Q Which templates/applications have user account requirements
O How to create the service account and grant proper access permissions in
the following environments:
B Exchange 5.5 nodes in a Windows NT domain
B Exchange 5.5 nodes in a Windows 2000 domain
B Exchange 2000/2003 nodes in a Windows 2000/2003 domain
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User Privileges
There are 2 levels of user privilege needed by the Exchange SPI:
1. HPITO Account

All templates in the Quick Start group, and some templates in the Add-Ons and
Advanced groups, run under this type of account. No customization to templates
is required, only threshold changes if desired.

2. Service account user with special Exchange privileges

TEMPLATES: Some templates in the Add-Ons and most templates in the
Advanced group run under this type of account:

®  EXSPI Advanced > EXSPI End to End Message Ping > EXSPI-55/60
End to End Message Ping. These templates use the mailbox created by
the Exchange SPI application Mailbox Config.

m  EXSPI Advanced > EXSPI Reporter Collection > all templates. These
templates use the Mailbox created by the application Exchange SPI
Mailbox Config, to extract information from the public folder and
mailbox tables via MAPI (Messaging Application Programming
Interface).
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Creating a Service Account with Proper
Access Permissions

Some templates and applications require a service account for each logon
domain where Exchange servers reside (see Exspi Template Group Requirements
chapter 4 page 89). This service account enables the Exchange SPI to access
information from the Exchange database.

The service account must be created and the access privileges granted.
Procedures are outlined according to operating system environment, in the
following manner:

B Case 1: For Exchange 5.5 nodes in a Windows NT Domain

B Case 2: For Exchange 5.5 nodes in a Windows 2000 Domain

B Case 3: For Exchange 2000/2003 nodes in a Windows 2000/2003
Domain
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Exchange 5.5 nodes in a Windows NT

Domain

CREATE USER ACCOUNT

1. Logon as Domain Administrator of the domain to which the Exchange

server belongs.

2. Select Start > Programs > Administrative Tools (common) > User
Manager for Domain.

3. Select User > New User. In the dialog that appears create a new user as

follows:

i User Manager - MX-EX

IEDN YYiew Policies

Mew U zer...

Mew G lobal Group...

Mew Local Group...

Optionz  Exchange

=]
Help
r
""" HF [TO account o

Capy... &
Delete Del
Hename...

Broperties... Enter
Select Users...

|Dt:5t:riptiun

Select Domair. .

Exit Alt+F4

Dormain Guests

tembers can administer
Administratars hawe cam
Backup Operators can o4__
Enterprise cerification an
Designated administratal
Allworkstations and ser
All dormain contrallers int

All domain guests

AL
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Username: MSXSPI

Full Name: OVO Exchange SPI
Description: Exchange SPI for OVO
Password/Confirm Password: Ak

NOTE: Remember this password; you will need it later to update applications and
templates.
New User dialog
Hew Uszer

Username: |I'v1 SHSPI Add
Full Name:  [0V0 Exchange SPI Cancel
Description:  |Exchange SPI for 0VD Help
Paszword: e
Conim
Pazzword:

[ User Must Change P assword at Next Logan
[ User Cannot Change Passwiord

Iw Pazzword Never Expires

[ Account Disabled

£

Groups

BN

Account

L%
Profile

Hours

=+

Logon Ta Dialin

:P:'}-H ‘

This password must be entered but will not be authenticated
later.

4. Deselect User Must Change password at Next Logon and select
Password Never Expires.
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5. Click the Groups button to display the Group Memberships window.
Group Memberships dialog
Group Memberships

zer  MS=S5PI[0V0 Exchange SPI)

Cancel

dild.

Help

Member af: Mat member of:

Cert Publizhers ;I
Domain Computers
Domain Controllers

D-:umalr'! Guests_ -
3

Cramain Admins
{‘,‘_i Diamain Users

Set I Primary Group:  Domain Users

6. At the right, from the Not a member of: box select the Domain Admins
user, click Add, and OK to close the Group Memberships window.

7. To include necessary information, click buttons in the New User window:

i G | @ | =k | R
Groups Prafile {Howrs Logon To | Account Dialiry
Profile: No User Profile should be specified.
Hours: All hours of the day and week should be allowed.
Logon To: All workstations should be specified.
Account: Should never expire/should be Global Account.

8. Click Add to add this user. (If the Exchange Add Mailbox window is
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displayed, select Cancel to close it).
9. Click the Close button to close the New User window.

10. From the User Manager menu bar select Templates > User Rights....

User Manager dialog

i User Manager - Mx-EX H=] B3

Uzer  View BEeM==8 Dptions  Exchanoe Help

LUsername

Trust Relationzhips...

|
|Dt:scriptiun

sl ACCount Operatars bMembers can administer o &)
s Administrators Acdministrators hawe compl

& Backup Operatars Backup Operators can owve

& Cert Publishers Enterprize cenification and
et Dormain Adming Designated administrators
4 Domain Computers Al workstations and server—
dat Dormain Controllers All dormain contrallers in the
et Dormain Guests All domain guests

# Domain Llsers All damain users

i Enterprise Admins Designated administrators
dia Exadmin

ia Exchange Domain ServerExchange Domain Servers »

11. Check the Show Advanced User Rights checkbox.

12. From the drop-down list select Log on as a service in the Right field
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Selecting Log on as a service for User Rights.

s Uzer Manager - MX-EX =] E3
Uzer “iew Policies Options Ewxchiange  Help
Username |Fu|| Name |DE|
€ la_admin la_admin -

& Iala Ia Ia

Groups Uszer Rightz Policy

e Accournt
i Acdiminis
il Backup
{3 Cert Pur Right ILu:-g Oh a3 a service LI ﬂ
e Clormain

_ : Help
= Dormain Grant Ta
# Domain [Account Unkrown ;I
L Domain || admiisteator [Sdministrator)
dae Oomain |HPITO account (HP I TO account] J
Wed Enterpri: |HP- TH E.ﬁ.ccnunt [HP-TRC-Account)

& Exadmi
A Exchant

Diomnain: I-Ex ok

IH

Bemove

it |

¥ Show Advanced Uzer Rights

13. Click the Add button to open the Add Users and Groups window.

14. Click the Show Users button.

15. Select the user account just added (MSXSPI), click Add, then OK.
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Adding the new User Account

Add Users and Groups
List Mamesz From: I@. B 5 - ;I
MHames:
’:E maxspi [0W0 Exchange SPI) LI
€ mexspias
ﬁ msxspid3

ﬁ MS=SPIEXDZ2 MSRSFIEXDZ)
€ MSSPIEXD [MSXSPIEXD3)
€ MSSPIROSA09E5E 2K [MSXSP

ﬁ MS=SPIROSE4155TST [MSHSP 1
ﬁ MS=SPIRDSB4196W 2K, [MSxSF ll
Sdd Shovr sers tembers... Search... |
Add Wames:
M-EX\mssspi a
Ok Cancel | Help

16. Repeat steps 12-15 to add the Profile system performance right.

GRANT EXCHANGE ACCESS PERMISSIONS TO USER
ACCOUNT

In order for the user account (in this example MSXSPI) to have access to a
mailbox as well as the Exchange IS Public and Private databases, it must have
Exchange Admin permissions. Use Exchange Administrator to grant these
permissions at the site level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange
Administrator.
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For each Exchange site where Advanced templates are to be distributed:
a. In the left pane within the tree, select <site_name>.
b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the
Add Users and Groups window.

d. Select the user account previously created (MSXSPI), and click Add.
e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.
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Verifying the User role

o Microzoft Exchange Adminastrator - [Server ROS53076TS5T1 in Site mx-... N=lE

%Eile Edit “iew Toos “Window Help

=18] x|

|ROS53076TST1

i ] e e ) i

=l
I& m-exBR-0ng

Digplay Mame +

Address Book Yiews
[El---- Folders
------ @ Global duddress List

59

mx-exh5-site Properties

General Pemiszions |

& mx-exb5-site

—Windows NT accounts with permissions

Configuration

[

£ Recipients

€ Testl

w
1
fa]

brooount 4 | R ale

| Add

€ MxExhafshind
€ Mx-Excbidie

Service Account Admin.
Admin.

€ M-ExMa_admin Service Account Admin.

-Ehmsspi i,
[ 6 MxExy i Admi

;l dd...
_I Bemove |
-|

Kl

Roles:

Admin. hi

o

ok ]

Cancel

&pply Help

g. Click OK to save the changes.
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Exchange 5.5 nodes in a Windows 2000
Domain

CREATE USER ACCOUNT
1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Programs > Administrative Tools > Active Directory
Users and Computers.

3. Expand the Active Directory of Users and Computers, right-click Users,
and select New > User.
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Selecting New User dialog

-fé Active Directory Users and Computers

s 15 TR b [ I'g = » e : |
; ; ; i =y 7 | @ || 2
|| Acion iew || & = | [£]]F0 | X B eledavaes |
1 Delegate Conkral... :—_Ll:se_rs 69 Dl:l]_El:tS
e TR I
# ruitars i..NamE ...... e
Camputer
All Tasks v Conkack
Grou
Mews Windows From Here ; :
__________ Prinker
Refresh User
Export List.. . Shared Folder lishers
; LB 18 Diomain Admins
Properties )
ﬁDDmaln Computers
Help ﬁDDmain Controllers
ﬂEDDmain Guests
!ﬁDumain sers

ﬁEnterprise Adrmin s
fﬁEXadmin

!ﬁExchange Domain Servers
ﬁExchange Enterprise Serwvers
ﬁExchange Services

ﬁ Exchange-Buffaon -
1 | 24l | 3

— :
{Create a new object. .. | [

4. In the dialog box that appears, enter the user name just created (in this
example MSXSPI) as the First Name and as the User logon name.
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New object dialog

New Object - User |

g Create ;. me-ex.ov.roze hpocomdU s ers

s [MsxsF [ |

Last name: !

Full name: imsxsm

Uzer logon nanme;

iMEXS Fl i {ahi-ex, 0w, roze. hpocom _:_!
Uzer logon name [pre-windows 2000];
iMX-EK‘x IMSKSF’I
¢ Back Hext > ' Cancel

5. In the next window, enter Password/Confirm Password for the user
account (MSXSPI).

6. Select Password Never Expires. Then click Next
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Setting User Privileges.

New Object - User |

g Create ;. me-ex.ov.roze hpocomdU s ers

Fazzwiord:

Ixxx:r:x

Confirm password: ixxxxj

[T User must change password at next logon
[ User cannat change password

¥ Pazaward never expires

[T Account is disabled

< Back Nest » ' Cancel

7. Inthe New Object dialog, deselect Create an Exchange mailbox, and
click Next.
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Deselect Create an Exchange Mailbox

Mewr Object - User |

ﬁ Create in:  mx-ex.ov.roze hp.comd/U sers

SEMVET

; hd<-E = First Adminiztrative Group/E=01 i i

i aflboy Shore

| 3

< Back Mext » Cancel

8. In the next dialog, complete creating the user by clicking Finish.

9. You are now back at the Active Directory Users and Computers dialog.
In the right pane, right-click on the user just created (in this example
MSXSPI) and select Properties.

10. In the MSXSPI Properties page, select the General tab. Enter “Exchange
SPI for OpenView Operations for Windows” in the Description field.
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msxspi Properties

Published Certificates | MemberOF | Diakin | Object | Secuity |
Environment ] Jesziong ] Remote control ] Teminal Services Profile ]
Exchange General ] E-maill Addreszes ]
Exchange Features ] Exchange Advanced ]
General l Addresz ] Account ] Frafile ] Telephones ] Organization ]

g MEREi

Firzt name:

Initials:

Last name: |

Digplay name: ||:|‘J|:| E vehange SPI

Description: |

Dffice: |

E -mail: |msxspi@m:-:-e:-:.u:w.ru:use:.hp.u:u:um

Web page: | Other...

ok Cancel

T elephone number: | Other.... |

11. Select the Member Of tab. Click Add
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Setting User account privileges

E nwinonment ! Sesziong ! Remaote control i T erminal Services Profile
Exchange General ; E-rnail Addresses

eneral i Addrezs ! Accaunt i Profile i Telephones ! Organization

Exchange Features a Exchange Advanced i
Published Cettficates  MemberOf | Diskin | Object | Secuiy |

Member of;
[ ST R | &ctive Directory Folder :
Domain Users rr-eR. oy rozes. hip. comd U sers

s 5elect Groups E

Look in: !E&g Iris-e. o, rose, hip.com

g
Mame | In Folder i_:
ﬁ Drornain Computers -, o roze. hp.comdd sers
m Dornain Controllers m-ex. ov.1ose. hp. comdU sers
ﬁ Scherma Adminsg r-ex. o rose. hp. comdU sers
ﬁ Enterprize Adminz m-ex. o rose hp.comdJ sers b
m Cerk Publishers mx-ex. o roze hp.comUsers

Jomain Adrming ro.roze hp.comdl sers

ﬁ Domain Users e 0w 1oge. hpcomdU sers 2

Add S j

Domain Adminz

] Cancel

12. In the Select Group dialog select Domain Admins from the top pane.
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Click Add, then OK.

13. The new user (MSXSPI) is now a member of Domain Admins group. Click
OK and exit the Active Directory Users and Computer dialog.

New User with new Membership status

msxspi Properties !

Environmert i SEeszions i Remate control i Terminal Services Prafile i
Exchange General ] E-mail Addreszes i
Exchange Features i Exchange Adwvanced i
General i Address l Account ; Prafile i Telephaones i Crganization ]
Published Cettiicates ~ Member OF | Diskin | Object | Secuity |

Member of;

M ame | Active Directary Falder . {

Diormain Adrmins rm-ex. o rose. hp.comU sers
Darnain Uzers ri-eR. v roze. hpocomAU zers

Primary aroup; Domain L sers
Set Primary Group There is no need to change Primary group unless
o K wou have Macintosh clients or POSEE-complant
applications.
Ok, ' Cancel Spply i Help |
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GRANT EXCHANGE ACCESS PERMISSIONS TO USER
ACCOUNT

In order for the user account MSXSPI to have access to a mailbox as well as the
Exchange IS Public and Private databases, it must have certain Exchange Admin
permissions. Use Exchange Administrator to grant these permissions at the site

level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange
Administrator.

2. For each Exchange site where Advanced templates are to be distributed:
a.. In the left pane within the tree, select <site_name>.
b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the
Add Users and Groups window.

d. Select the user account previously created (MSXSPI), and click Add.
e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.




Verifying User
'~ Microsoft Exchange Administrator - [Server ROS53076T5T1 in Site mx-__ _ O] x|

@&, File Edt View Taocls ‘window Help =1&| x|
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roles.

|RO

sEaeTsTt 7| | ~ ol B %] &

7]
1
[u]

------- Address Book Yiews Configuration =]
Falders Fecipients
il Global Address List Testl

= @

rme-exBb-org Dizplay Mame

mx-exhh-site Properhies >

General Pemizzionz |

& mx-exb5-site

—"Windows MT accountz with permizsions

_Bcocount / | Fole | Add..
€ MHExhalshing Service Account &dmin, ;I E——
€ MH-Exhchidie Adrmin. Bemove
£ bx-Exha_admin Service Account &dmin, —I

| €5 ME-Ex\msxspi Admin, - |

Kl o

Raoles:

Adrmin. hd

ak Cancel &pply Help

g. Click OK to save the changes.
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Exchange 2000/2003 nodes in Windows
2000/2003 Domain

To create a service account with special Exchange privileges for Exchange
2000/2003 nodes the following steps are required:

B Enable viewing of the Administrative Groups folder
m  Create the service account

B Add the service account user to the Local Administrators group.

ENABLE VIEWING OF ADMINISTRATIVE GROUPS FOLDER

To create the user account it is necessary to first enable viewing the
administrative groups folder:

1. Open the Exchange server Properties
2. Select Display administrative groups.

3. Click Apply and OK.
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Exchange Server Properties Dialog

Exchange Demo Properties ;

General | Details |

Exchange Demo

Jid et

— &dministrative views

Configure whether pour organization emplops routing groups and
admiristrative aroups.

[ Dizplay routing groups
¥ Display administrative groups

Operation made:

IMi:-:ed Mode [zan support pre-Exchange 2000 Serverz)

Change operation mode

The change to native mode can not be reverzed.

Change Mode |

k. I Canicel Apply

Help
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CREATE USER ACCOUNT

1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Settings > Control Panel > Administrative Tools > Active
Directory Users and Computers.

3. Expand the Active Directory Users and Computers and right-click Users
and select New > User.

Active Directory Users and Computers dialog

f.é‘ Active Directory Users and Computers = =

[sté Console Window  Help -_IE

| aton yew || & = | B | X B2l edhvEo

T A R e e

; f_l_l'l'j- i riikRrs i..NamE ______
&l Tasks r Conkack
Mew Window From Here Gr.cuup
__________ Prinker
Refresh User
Export List. .. Shared Falder lishers
_ S T  Tromain Admins
Properties )
mDDmaln Campukers
Help ﬁDDmain Contrallers
ﬁDDmain Guests
mDDmain sers
ﬁEnterprise Admin s

mEXadmin

ﬁExchange Daomain Servers
ﬁExchange Enkerprise Servers
ﬁExchange Services

ﬁ Exchange-Buffoon

<] | 2l | 2

! ——— :
|Create a new object. .. i [

-

4. In the New Object - User dialog, enter a user name for the new service
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account into the First Name and the User logon name fields.
You must create a service account with these privileges in each Windows domain.

Entering the new service account name

Mews Object - User |

ﬁ Create in.  ms-exov.roze.hp.com/Users

B [M&xSP ' nials: |

Last narme: !

Full name: iMSKSF‘I

Uzer logon name:

IMSXS F i (Srmy-ex. o, rose. hpocom _:_’
Uzer logaon nanme [preindows 2000];
IMK-EK\ IMSHSF‘I
¢ Hack Mest Canicel

5. In the next window, enter Password/Confirm Password for the service
account.

6. Seclect Password Never Expires. Then click Next.
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Setting password properties

Mews Object - User

ﬁ Create in.  ms-exov.roze.hp.com/Users

=]

Pazsword:

Ixxx:::x

Confirm password: ixxxxj

[T User must change password at next logon
[T Uzer cannot change password
IV Pazsword maver supires

[T account iz dizabled

< Back Mext >

Cancel

7. Inthe New Object dialog, deselect Create an Exchange mailbox, and

click Next
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Deselecting creating a mailbox

New Object - User |

g Create ;. me-ex.ov.roze hpocomdU s ers

SErver

; bdw-Ex A Firet Adminiztrative Group/E=O1

tailboy Shore

i =

< Back Nest » Cancel

8. In the next dialog, complete creating the user by clicking Finish.

9. You are now back at the Active Directory Users and Computers dialog.
In the right pane, right-click on the service account user just created and
select Properties.

10. In the service account Properties page, select the General tab. Enter OVO
Exchange SPI in the Display name and Description fields.
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Entering names in Properties dialog

msuspi Properties [ 2]

Published Certificates | MemberOF | Diakin | Objest | Securty |
Environment ] Jessions ] Remate control ] Teminal Services Profile ]
Exchange General ] E-mail Addreszes ]
Exchange Features ] Exchange Advanced ]
General l Address ] Account ] Profile ] Telephones ] Organization ]

g MR

Eirst name:

Iritialz:

Last name: |

Digplay name: ||:|U|:| E uchange SPI

Dezcription: |

Office: |

E -mail: |ms:-cspi@m:-:-e:-:.u:uv.ru:use:.hp.u:u:urn

Weh page: | Other...

] Carcel

Telephone number: | DOther... |

11. Select the Member Of tab, and click Add.

12. In the Select Group dialog select Exchange Domain Servers from the top
pane.

13. Click OK and exit the Active Directory Users and Computer dialog.
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Confirming membership privileges
msuspi Properties [ 2] |
I E xchange General

Teminal Services Profile
Exchange Features

E-mail Addreszes
General | Addrezs I Account I Frofile I Telephones I Crganization

tember Of Diialin I E revironment I Sezsion: I Remote control
Member of:
E= | Active Directony Folder
Diomain sers rre-e. o, roge. hp.comdU sers
rre-e. o roge. hpocomdU zers

Ewchange Domain Servers

Add.. | Hemove |

Frimany group: Diomain Uzers
R e There iz no ne,au:l ko chgnge Frimary group u_nless
= . - you have Macintosh clientz or POSE-compliant

applications.

k. I Cancel Apply Help

14. Add the service account user to the Local Administrators group on the

Exchange server.

a. On each targeted Exchange 2000/2003 server, select Start > Settings >

Control Panel.
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b. Double click Administrative Tools. Double click Computer
Management, then open the Local Users and Groups folder. Select
and open the Groups folder, then double click Administrators.

c. In the Administrators Properties dialog, click the Add button. Select the
correct Domain from the Look in drop down list. Select the new service
account user from the list, and click Add. Click Apply and then OK.

Adding service account user to Local Administrators group
Administrators Properties EH I

General |

@ Administrators

Diescription: Admiristrators have complete and unrestricted access b

Members:

m.ﬁ.dministratur
€7 APPSFINDamain Adrmins
C EAPPSP S\ mexspi
E HF ITO account

k. I Canicel Apply
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NOTE: It can sometimes take a few hours for new group membership and rights to be
applied to a service account
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Introduction

This chapter offers instructions for installing, configuring and removing
Exchange SPI components. It covers the following topics:

Q Prior to installing Exchange SPI
Q Installing and configuring the Exchange SPI

B Template Groups: installation considerations
B Installation and Basic Configuration
B Advanced Configuration

Q Removing the Exchange SPI
Q Deleting Exchange SPI templates, applications and message groups.
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Prior to Installation

This release is targeted at OVO for UNIX 7.x or higher. Please verify
your current OVO version.

Before installing this version of the Exchange SPI, any previous version
of the Exchange SPI must be removed, see Deinstalling Exchange SPI
chapter 3 page 81.

The installation of Exchange SPI depends on the following pieces of
software: DSI2DDF (Version >= A.01.12.00) and SPI-SVCDISC-OVO
(version = A.02.00). Verify that these are present on the management
server before installing the Exchange SPI.

Every installation of the Exchange SPI requires a basic configuration
procedure which is detailed in the section Installation and Basic
Configuration chapter 3 page 56.

A more advanced configuration procedure is required before
distributing some of the Add-Ons and Advanced templates, for example
those for collecting Exchange folder and mailbox information, and
testing connections between servers. See Advanced Configuration
chapter 3 page 66 for the advanced configuration procedures.

The Exchange Service Discovery application has some requirements,
please see Prerequisites for Exchange SPI Service Discovery chapter 4
page 94.

Some templates require a service account with special Exchange
privileges. See Exspi Template Group Requirements chapter 4 page 89
for template requirements, and see Creating a Service Account with
Proper Access Permissions chapter 2 page 22 for procedures.

Exchange SPI requires a data collection agent - OpenView Performance
Agent [also known as MeasureWare Agent] or OpenView Operations
Subagent 12 [included with OpenView Operations 7.0], to collect data
for reporting and graphing purposes. Use the Exchange SPI application
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EXSPI Add DataSource to configure the data source and start logging
data.

B Exchange SPI reports require HP OpenView Reporter. Exchange SPI
graphs require HP OpenView PerfView. HP OV Reporter and the
Exchange SPI EXSPI-Reporter.msi need to be installed on any
Windows node in the domain where Exchange SPI is managing nodes.

TEMPLATE GROUPS: INSTALLATION CONSIDERATIONS

After installation, you can view the Exchange SPI templates using the
Templates>Reload Templates command in the Message Source Templates
window.

In OVO for UNIX version 8, templates are referred as policies.

Exchange SPI templates are located under the SPI for Exchange group and can
be distributed as groups or individually. The groups are as follows:

m  SPI for MS Exchange: under this folder are the version specific
folders Exchange 55, and Exchange 2000 and 2003. Template groups
are listed here with xx indicating the version number 55 (for Exchange
5.5) or 60 (for Exchange 2000 and 2003). The requirements for each
group are as follows:

* EXSPI-xx-Quick Start templates, in general require the HP ITO
Account, see Exspi Template Group Requirements chapter 4 page
89.

* EXSPI-xx-Add-Ons templates are designed to monitor specific
software components, which may or may not be installed on the MS
Exchange Server (for example, Lotus Notes must be installed for the
EXSPI-60 Lotus Notes Connector templates to work). Select
templates for the software components you are using on the targeted
MS Exchange Server.

+ EXSPI-xx-Advanced templates and EXSPI-xx-Add-Ons generally
require a service account with special Exchange privileges. See
Creating a Service Account with Proper Access Permissions chapter




Chapter 3: Installing & Configuring the Exchange SPI
Prior to Installation

2 page 22 for details.

All data collection templates require that a data collection agent (the OV
Performance or OVO subagent) is installed and running on the managed node.
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Installation and Basic Configuration

The Basic Exchange SPI configuration is designed to get you started quickly,
using the Quick Start and Exchange Service Discovery template groups that
require only the HP ITO Account as a basis for server monitoring. Many of the
templates in the Add-Ons and Advanced template groups require a service
account with special Exchange privileges, which requires the more Advanced
configuration procedure covered later in this chapter.

When the basic installation and configuration procedure is complete, you will
have completed the following tasks:

Q Task 1: Install Exchange SPI on the management server.
O Task 2: Add nodes to the node group EXSPI.

O Task 3: Install OVO agents on all MS Exchange server systems (required
if the OVO Windows agent is not yet distributed).

Q Task 4: Install OVO agents on the management server (needed for some
of the OV utilities that are used by Exchange SPI applications).

Q Task 5: Assign responsibilities for the OVO Operator.

Q Task 6: Distribute Exchange SPI actions, commands, monitors to the
Exchange servers.

Q Task 7: Configure data sources.

Q Task 8: Assign and distribute template groups to managed node(s) running
MS Exchange server.

TASK 1: INSTALL EXCHANGE SPI ON THE MANAGEMENT
SERVER

Prerequisite: It is not necessary to stop OVO sessions before beginning the
Exchange SPI installation, however the following need to be installed on the
management server:

B OpenView Operations (OVO) for UNIX version 7.x or higher

®  DSI2DDF (A.01.12.00 or greater).

®  SPI-SVCDISC-OVO (A.02.00).
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The instructions that follow show the command line usage of swinstall. For
HP-UX systems you can also use the graphical user interface (GUI), but the
procedure is not covered here.

The Exchange SPI is available on the HP OPenView Operations for UNIX
Applications CD-ROM. There are two CDs in the Applications CD-ROM set, the
first contains the products’ management server install packages, and the second
contains the OpenView Reporter and OpenView Performance Manager
integrations for the applications. At this point use the first CD.

For an HP-UX 11.0 management server, enter:
swinstall -s /cdrom/OV_DEPOT/11.0HPUX.sdtape SPI-EXCHANGE-OVO
For a Selaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape SPI-EXCHANGE-OVO

TASK 2: ADD NODES TO THE NODEGROUP

Upon installation Exchange SPI creates a Node Group EXSPI. All Exchange
nodes to be managed should be added to this node group, so that tasks such as
installing agent software, running applications, and distributing
actions/commands/monitor/templates can be done for the whole node group,
instead of needing to select each node.

TASK 3: INSTALL OVO AGENTS ON MS EXCHANGE
SERVERS

Install an OVO Windows agent on all MS Exchange servers. (If you need details
for installing the OVO agent, refer to the OVO Installation Guide for the
Management Server.)
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TASK 4: INSTALL OVO AGENT ON OVO MANAGEMENT
SERVER

Install an OVO UNIX agent on the OVO Management Server. (For details on
installing the OVO agent, refer to the OVO Installation Guide for the
Management Server.)

This is required for the Exchange SPI applications that run on the management
server.

TASK 5: ASSIGN RESPONSIBILITIES FOR OVO OPERATOR

All target hosts for Exchange SPI must be OVO managed nodes and must be
running on an OVO intelligent agent.

1. Logonto OVO as the OVO administrator (opc_adm).

2. Select Window > User Bank
a. Select the opc_adm user
b. Choose Actions > User > Modify
c. Press the Responsibilities button and use the Responsibilities for Operator
(opc_adm) window to view messages.
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The Responsibilities for Operator window

¥ Reszponsibilibies for Dperator [opec_adm]

3. In the Node Group that contains your Exchange managed node, select the
following Exchange SPI message groups:

m  EXSPI
m EX Fault
m EX Perf

4. Use the Actions > Browser > Start/Reload from the OVO User Bank menu.

TASK 6: DISTRIBUTE EXCHANGE SPI ACTIONS,
COMMANDS, MONITORS

To collect Exchange data, you must complete the following steps:
1. Distribute Exchange SPI actions, commands, monitors to the Exchange

servers by selecting Actions>Agents>Install/Update SW & Config from the
OVO Node Bank menu.
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Install/Update OVO Software and Configuration window

i Inztall # Update VPO Software and Conbguraton

2. In the Install/Update OVO Software and Configuration window check the
following checkboxes to select components:

B Actions
B Monitors
B  Commands
3. Check the Nodes in List Requiring Update checkbox.

4. Check the Force Update checkbox.

5. If anode was not selected previously, select the node in the Node Bank and
use Get Map Selections to add the Exchange server(s) to the target node(s)
list.

6. Click OK.
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7. The following message is displayed in the message browser:

The following configuration information was successfully
distributed: Actions, Commands, Monitors

TASK 7: CONFIGURE/UPDATE DATA COLLECTION AGENT
DATASOURCES

The OVO data collection agent collects, logs, and timestamps data from
individual systems. If you use OV Performance Agent (MeasureWare Agent),
you can use PerfView to graph the data; if you use OpenView Reporter, you can
use it to generate reports displayed as Web pages.

1. Atthe OVO console, from the Window menu, select Application
Bank>EXSPI Admin.

2. To create data sources for the OVO data collection agent, run EXSPI Add
DataSource for each managed node.
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Adding Datasource for HP OpenView Subagent (CODA)

| % Output of Application No. 6
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Adding Datasource for OV Performance Agent (MWA)

¥ Dutpust of ﬁ.|_'|[.|||::._||i|:||"| Mo, &

NOTE:

TASK 8: ASSIGN/DISTRIBUTE QUICK START TEMPLATES

In OVO for UNIX version 8, templates are referred as policies.

The following section outlines the procedure for the assignment and distribution
of templates to the managed nodes.
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1.

2.

10.

11.

12.

13.

Open the OVO Node Bank.
Select the desired managed node(s) designated to run Exchange SPI.

To assign (select) the templates for distribution, select
Actions>Agents>Assign Templates from the menu bar.

In the Define Configuration window select Add.
In the Add Configuration window select Open Template Window....

In the Message Source Templates window double-click the SPI for
Exchange group to display the subgroups.

Select, and double-click Exchange 2000 and 2003 or Exchange 5.5.
Select the desired EXSPI template group or individual template(s).
Click Get Template Selections from the Add Configuration window.
Click OK from the Add Configuration window.

Click OK from the Define Configuration window.

The desired templates have been selected for distribution. Next, distribute
them to the managed nodes.

To distribute the assigned templates, select Actions >Agents>Install/Update
SW & Config from the Node Bank menu.

In the Install/Update OVO Software and Configuration window check the
Templates checkbox to select it.
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14.

15.

16.

Check the Nodes in List and the Force Update checkboxes.

If a node was not selected previously, select the node in the node bank and
click Get Map Selections to list the target node(s), then click OK to
distribute templates to the managed node(s).

The following message is displayed in the message browser:

The following configuration information was successfully
distributed: Templates

The Exchange SPI templates are distributed to the selected managed
node(s). Exchange SPI monitors will begin running.

You have now completed the standard Exchange SPI installation and
configuration process.
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Advanced Configuration

Prerequisite: Complete tasks in the Installation and Basic Configuration
chapter 3 page 56 section.

Advanced configuration covers the distribution of templates that require a
service account with special Exchange privileges. When finished, you will have
completed the following tasks:

Q Task 1: Create the service account.

Task 2: Grant Exchange Access permissions to the user.
Task 3: Configure the service account on managed nodes.
Task 4: Enable message tracking.

Task 5: For each Exchange server create the MSXSPI<host name>
mailbox.

0000

O

Task 6: Configure MS Exchange servers for End to End Message Ping.
O Task 7: Assign/distribute templates.

The Exchange SPI can be configured to accommodate cluster environments
where fail-overs allow uninterrupted Exchange availability, see Using Exchange
SPI in high availability environments chapter 5 page 108 for more information.n

TASK 1: CREATE THE SPECIAL SERVICE ACCOUNT

A service account with special Exchange privileges is needed for each Windows
logon domain where your managed Exchange servers reside. See the procedures
in Creating a Service Account with Proper Access Permissions chapter 2 page 22
for details on creating this type of account in Windows NT and Windows
2000/2003 operating environments.

TASK 2: GRANT EXCHANGE ACCESS PERMISSIONS TO
SERVICE ACCOUNT

See the procedures in User Privileges chapter 2 page 21, where the procedures
for granting proper access permissions for each combination of
Exchange/Windows environment is outlined.
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TASK 3: CONFIGURE MANAGED NODES

1. Select all the Exchange managed nodes you wish to configure in the OVO
Node Bank.

2. Drag these nodes and drop them on the EXSPI Node Config application
located in the EXSPI Admin application group.

3. When prompted, enter the domain, user and password for the user account
(created in Task 1: Create the special service account chapter 3 page 66).
NOTE: When you run this application, be sure to enter the correct domain
name, user and password. This domain is not the DNS domain name but the
NT domain name.

‘% EXSPI Mode Config
%4 Mode Config for the Node @ ntl3475, appspi,com

Flease enter a user account that iz set-up as an Exchange Administrator
Domain @ appspi

llzername: administrator

Enter pazsword:

Re-enter pazsword:

%% Configuring node "ntl8475,appspi.com” ..

Please press [RETURMI to continue ... [

NOTE:

If Exchange nodes are managed at a later date, perform this procedure for all
newly managed Exchange nodes.
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TASK 4: ENABLE MESSAGE TRACKING

To ensure that all messages routed through a server are added to the OVO
message tracking logs you need to enable message tracking. You can record
information about the sender, the message, and the recipient. If you need to log
more detailed information, you can also record the subject line of the email
message.

4A: ENABLING MESSAGE TRACKING FOR EXCHANGE 5.5

1. Select Start > Programs > Microsoft Exchange > Microsoft Exchange
Administrator.

2. Expand the site level and Configuration to view selections beneath it.
3. In the details pane double-click Information Store Site Configuration.

4. In the Information Store Site Configuration Properties dialog, check
Enable message tracking, and select OK.




Information Store Site Configuration dialog

Information Store Site Configuration Properties
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General Permissions |

0

g

et

%

Information Store Site Configur...

Public Falder Affinity
Top Level Folder Creation

Dizplay name:

Directary name: ISite-MDB-Eanig

IInfu:urmati-:un Stare Site Configuration

Public folder container

|
Modify.... |

¥ Enable message tracking

Created Haome site;

B/2/00 7231 PM

ROS-PARADE

Last modified
B/2400 731 P

o ]

Cancel

apply Help

5. Repeat steps 3 and 4 for MTA Site Configuration.
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MTA Site Configuration dialog

MTA Site Configuration Properties

General | F'ermissiu:unsl M ezzaging Defaultsl

@ MTA Site Configuration

Dizplay name: IMT.-’-‘-. Site Configuration

Directony name: ISite-MT.-‘l‘-.-Eanig

¥ Enable message tracking

Created Haome =zite; ROS-PARADE Last modified
B/2/00 731 P B/2400 731 PR

] 4 I Cancel Apply Help

If the Internet Mail Service connector does not exist, skip the following
steps.

6. In the left pane select Connections.

In the right pane select Internet Mail Service, check the Enable message tracking
checkbox, and click OK.

4B: ENABLING MESSAGE TRACKING FOR EXCHANGE 2000
AND 2003

Use the Exchange SPI application Enable Message Tracking to set message
tracking on, for servers only. All messages that are routed through the selected
servers will then be added to the message tracking logs. This information is
collected by the EXSPI-60 Dc-TrackLog Data collection templates. You can
record information about the sender, the message, and the recipient. If you need
to log more detailed information, you can also record the subject line of email
messages.
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The Enable Message Tracking application needs to be modified to include the
user name and password of a service account that has Exchange administrative
privileges. Open the Enable Message Tracking application, and add the user
name and password.to the Execute as User field, before executing.

Enabling Message Tracking for Exchange 2000 and 2003

¥ Dulput of Application No, 5

TASK 5: CONFIGURE MAILBOXES

In addition to the MSXSPI user, a mailbox is required for accessing mailbox and
folder information, necessary for End to End Message Ping and Reporter
Collection templates. Use the Exchange SPI application MBOX Config (located
in the EXSPI Admin application group) to create the mailbox:

1. Modify the MBOX Config application. The user name and password of a
service account with Exchange administrative privileges needs to be given
for the application to execute. (Change the Execute as User field, add user
name and password.)
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2. Run the EXSPT MBOX Config application to configure mailboxes for the
Exchange servers (you can select multiple nodes simultaneously).

For each Exchange server a mailbox is created with the prefix MSXSPI and
Windows hostname. For an Exchange 5.5 server, EXSPI MBOX Config
application creates a mailbox MSXSPI<host name> for the primary Windows
account MSXSPI. For an Exchange 2000 or 2003 server, it creates the mailbox
MSXSPI<host name> for account MSXSPI<host name> (which it also
creates.)

For example, for the node rosspi4.rose.hp.com (Internet name) and Windows
name ROSSPI4 a mailbox is created called MSXSPIROSSPI4.

In order to create a different mailbox with a different name, see the procedure
Changing the Mailbox name chapter 7 page 159.

¥ Dubtput of Apphcation Mo, 4

NOTE:

If you receive an error in the above step or you cannot automatically create
mailboxes, you must manually complete the following on each Exchange
server:
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B For each Exchange server create a mailbox with the prefix MSXSPI
and Windows hostname.

B For Exchange 5.5, create this mailbox with primary Windows
account MSXSPI.

B For Exchange 2000 or 2003, create this mailbox with primary
Windows account MSXSPIROSSPI4 (this must first be created).

TASK 6: SET UP MESSAGE PING SERVER CONNECTIONS
AND ALARMS

To measure the round trip time required for a message to travel from one server

to another and then back to the originating server, you can use the EXSPI-60/55
End to End Message Ping template group.

With Exchange SPI version A.08.00 and later, pinging Exchange 5.5 servers
from an Exchange 2000/2003 server, or vice versa, is not supported.

Before you can use the End to End Message Ping templates, you must configure
the pair of servers that you want to test.

For Exchange 5.5 servers:
To configure the servers, complete the following steps:
1. Run the EXSPI Ping Config application on the OVO management server.

The EXSPI Ping Config application opens a default file as follows:
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Format of the file for Exchange 5.5 EXSPI Ping Config

E*SPl Ping Config

Format of the file:
Src-Sur:Src-MB: 1 tlest—ME: Timeout tMetSLA Al mostMetSLA

Sroc-Sur = Source Server {required)

Src—-ME = Source Mailbox f{optionall, Defaults to "MSKSPI<host_name:",

Rezerved = Reserved for future uze, leave empty

Reserved = Reszerved for future uze, leave empty

Dezt—HE = Destination Mailbox {required?

Timeout = Timeout {required’ {z—secondz, m-minutes, h-hours)

MetSLA = Met 5LA time {require for reports) {(s—seconds, m-minutes, h-hours)
AlmostMetSLA = Almost met SLA time {require for reports) (s-seconds, m-minutes, h-hours?
Examples:

EXCHL: 1 ¢ sMSHSPIERCHZ £ 25m 3 Ims 1
EXCH1:MSXSPTERCHL S £ 3 MSHSPTEXCHE £ 24 bm g
EXCHZ :MSKSPIERCHZ 1 £ s MSKSPTERCH4 £ 1k 20m: 1 0m
EXCHAsMSKEPTEXCHZ  + 1 MSRSPTEXCHA : 25m By

t84141 533 3MSRSPINTE4141 $ 2%m: Imsdm

T T T ¥ ¥ ¥ ¥ 3T OH oM H 3 HF M o H H o HH K HE

"Ffopt/OW/ERSP L conf fexepilnk_ebb, txt" 19 lines, 882 characters
Save configuration to “Aopt/IVAEXSPIAconffexspilnk_ebfa, txt"? [ues]

Configuration accepted,
Accept and install exspilnk_ebb,txt in monitors dir?lyes]
Installing exspilnk_gbh,txt in
Avarfopt OV shareddat abazes/0pC/mgd_node/customer/mz/intel /mt/monitordexspilnk _ebb, txt, 2

Pleaze distribute <monitorsr to all EXSPI managed nodes.

Pleaze press [FETURNI to continue ... ]
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2. Enter information about the servers to replace each entry separated by a
colon (@) in the format
Src-Srv:Src-MB: ::Dest-MB:Timeout :MetSLA:AlmostMetSLA

B Source Server - The server that the ping originates from. Each
server where EX-SPI is distributed has the same file, so the EX-SPI
collector/analyzer will parse this file and use all lines where the
Source Server matches the server where it is run from.

B Destination Server - The destination server, used only for SMTP
systems, is necessary only when the site directory does not contain
the destination mailbox. In this case, SMTP is used and the field
would contain the SMTP server name (the server following the
"@"; for example, the entry for mailbox
"brendan_belcastro@am.exch.hp.com", would contain
"am.exch.hp.com."

B Destination Mailbox (required) -The mailbox to send the ping zo.
This field is usually the only required destination entry.

B Timeout (required) (s-seconds, m-minutes, h-hours): - If a sent
message does not return in the defined timeout interval, EXSPI logs
it as a failure and sends a message to OVO. Failed messages are
tallied in terms of count and percentage within a report. The
timeout value must be larger than the values for MetSLA and
AlmostMetSLA so that a returned message can be processed using
these values. It may have Exceeded SLA even though it has not
exceeded the timeout interval. A Failed/Timedout message occurs,
therefore, only when the message never returns and the timeout
period is exceeded.

The minimum timeout value should be set slightly less than the collection
interval. For example, if the collection interval for metric 1002 is 30 minutes
(the default), the timeout should be set to at least 25 minutes. The logic is that
because the next measurement occurs only every 30 minutes, you should allow
up to that amount of time for any messages to return before "giving up" and
generating a failure. If you keep the timeout value within the collection interval
and the reply message does return, it can be processed as Met, Almost Met or
Exceeded as opposed to Failed/Timedout.
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B MetSLA (required for reports) (s-seconds, m-minutes, h-hours) -
If the round trip time is greater than this value, the message is
logged as either Almost Met SLA or Exceeded SLA. This value is
required if data is being sent to MeasureWare Agent DSI for
reporting (-1 option when running exspi_e2k.exe or exspi_e55.exe).
It is optional if only using alarms.

B AlmostMetSLA (required for reports) (s-seconds, m-minutes,
h-hours) - If the round trip time is greater than the MetSLA value
but less than or equal to MetSLA plus AlmostMetSLA, the message
is logged as Almost Met SLA. Otherwise, when the round trip time
is higher than MetSLA plus AlmostMetSLA, it is logged as Clearly
Exceeded SLA. This parameter is required if data is being logged to
MeasureWare Agent DSI (-1 option when running exspi_e2k.exe or
exspi_e55.exe), optional if only using alarms.

Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers that
denote the measurement units the value represents; for example, 4m (4 minutes)
30s (30 seconds) or 1h (1 hour). The default unit is seconds; for example, the
entry 4 is recognized as 4 seconds.

Procedure for EXSPI Ping Config for Exchange 2000/2003 servers

1. Select the Exchange managed nodes that you wish to configure in the VPO
Node Bank.

2. Drag these nodes and drop them on the EXSPI Ping Config application
located in the EXSPI Admin application group, under the appropriate
Exchange version.

3. A window appears with the configuration file, as shown in the figure below.

4. Edit the file as necessary, then click Esc.

5. You will be prompted to save the configuration. Accept the default choice
[Yes].

6. A validation will be performed to check if the Timeout is greater than the
sum of MetSLA and AlmostMetSLA. After validation, you will be
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prompted to accept and install the configuration file in the monitors
directory:
/var/opt/OV/share/databases/OpC/mgd node/customer/ms/nt/monitor/

7. You have completed configuring the end-to-end Ping, now distribute
monitors to the required EXSPI managed nodes. For details about
distributing the monitors, see Task 6. Distribute Exchange SPI actions,
commands, monitors chapter 3 page 59.

The format of the Exchange 2000/2003 EXSPI Ping Config file is:
Src-Srv:Dest-Srv:Timeout :MetSLA:AlmostMetSLA
The user only needs to fill in the following fields:

Src-Srv
Dest-Srv
Timeout (to be entered in seconds, with no suffix)

MetSLA (to be entered in seconds, with no suffix)

AlmostMetSLA (to be entered in seconds, with no suffix).
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EXSPI Ping Config for Exchange 2000 and 2003

¥ EXSPI Ping Config

|# Format of the file:
|# Src=SuriDest-Sur:Timecut :MetSLA:Al mostHetSLA

L

[# Sre=Sur = Source Server {required)

{# Dest-Sur = Destination Server (required)

|# Timeout = Timeout {required} {in seconds}

| Mote: Timeout should be areater than HetSLA + AlmostHetSLA
|# MetSLA = Met SLA time (required for reports) {in seconds)

|# AlmostMetSLA = Almost met SLA time {required for reports? {in seconds}
It ]

{# Examples:

| EXCH1:EXCH2:100:5:5

| EXCHL:EXNCHZ:B0:5:5

| EMCHZ EXCH4 : 10020210

# EXCH3:EXNCH4 :30:5:5

L

[NT84215:NT18475:100:10:10

Set Up Different Conditions/ Thresholds for Different Server Pairs
Using OVO Object Field & Alarming

(OVO High Level Expertise Recommended)

Alarms can be set to occur with metric EXSPI-60 1002 (Ping). Because you may
need to set different thresholds for multiple server pairs, the following examples
are offered. The examples show the syntax to insert in the template Conditions,
using the OVO object pattern fields so that you can set differing thresholds.
Metric 1002 sends the "FromMailbox,ToMailbox" in the object pattern fields
with the following definitions:

FromMailbox = FromServer:FromMailbox
ToMailbox = [ToServer]:ToMailbox
where [ToServer] is optional
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Config Entry

Object

EXCHI1:MSXSPIEXCH2:25m:1m:1m

EXCHI1:MSXSPIEXCH1,:-MSXSPIEXCH2

EXCH1:MAILBOXEXCHI:

EXCH1:MAILBOXEXCHI1,:MAILOXEXC

MAILOXEXCH3:2h:5m:2m H3

EXCH2:MAILBOXEXCH2: EXCH2:MAILBOXEXCH2,:MAILOXEXC
MAILOXEXCH4:1h:20m:10m H4
EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM | EXCH3:MSXSPIEXCH3,EXCH4.AM.HP.C
: OM:

MSXSPIEXCH4:25m:5m:5m MSXSPIEXCH4

For example:

ConditionName & Condition Object Pattern | Threshold Explanation

Type

EXSPI-60 1002.1 EXCHI1:MSXSPIEXCHI,: 120 Threshold condition for

+Message on MSXSPIEXCH2 ping between System

Matche(% Condition EXCHI and mailbox
MSXSPIEXCH2 on
system EXCH2. Object
pattern is case
sensitive.

EXSPI-60 1002.2 EXCHI:MSXSPIEXCHI,: 240 Threshold condition for

+Message on MSXSPIEXCH3 ping between System

MatchedCondition EXCHI1 and mailbox
MSXSPIEXCH3 on
system EXCH3. Object
pattern is case
sensitive.

EXSPI-60 1002.3 EXCHI1:MSXSPIEXCHI,: If the threshold was not

-Suppress MSXSPIEXCH2 exceeded for these two

Matched Condition EXCH1:MSXSPIEXCHI, system pairs, you must

MSXSPIEXCH3 suppress the message if

either of these system
pairs gets past 1002.1
or 1002.2.

EXSPI-60 1002.4 60 A blank object pattern

+Message on
Matched Condition

to catch all remaining
system pairs.




Chapter 3: Installing & Configuring the Exchange SPI
Advanced Configuration

TASK 7: ASSIGN/DISTRIBUTE ADVANCED/ADD-ONS
TEMPLATES

After completing the advanced configuration steps, you can assign and distribute
templates from the EXSPI Advanced and Add-On template groups to the
managed node(s) running MS Exchange server. Please refer to Task 8:
Assign/Distribute Quick Start Templates chapter 3 page 63 for procedures.

The EXSPI Advanced template groups contain two logfile templates which
capture Exchange warning and information events. Because Exchange generates
numerous warning and information events, you might want to assign these
templates only for troubleshooting Exchange:

m  Logfile EXSPI-60/55 Exchange Information

m  Logfile EXSPI-60/55 Exchange Warnings

You have now completed the advanced configuration installation process. The
Exchange SPI is ready to use.
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Deinstalling Exchange SPI

This process completely removes the Exchange SPI installation from the OVO
management server. Any customized templates or copies of Exchange SPI
default templates residing in other OVO template groups should also be
removed.

To reinstall Exchange SPI components with the original factory settings, see
Returning to original factory settings chapter 7 page 160.

Follow these steps in order to ensure a proper removal of the Exchange SPI:

REMOVING EXCHANGE SPI SOFTWARE FROM THE
MANAGEMENT SERVER

NOTE:The swremove program removes the files from the file system only. The
following components must be deleted manually:

B Exchange SPI templates in the OVO data repository.

B EXSPI Admin group must be removed from the Application bank
(see steps 9-12 in Deleting Exchange SPI templates, applications
and message groups section below).

m  EXSPI, EX Perfand EX Fault must be removed from the OVO
Message group bank (see step 5 in Deleting Exchange SPI
templates, applications and message groups section below).

m  EXSPI templates need to be deleted (see steps 1-4 in Deleting
Exchange SPI templates, applications and message groups section
below).

First, however, the Exchange SPI templates (and the Exchange SPI software)
must be deassigned from the managed nodes.

1. Open a terminal window and log on as root.

2. In the terminal window run swremove by entering:
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/usr/sbin/swremove SPI-EXCHANGE-OVO

DE-ASSIGNING EXCHANGE SPI TEMPLATES FROM
MANAGED NODES

1. Open the OVO Node Bank.

2. To deassign the templates from the node, select Actions>Agents>Assign
Templates from the menu bar.

3. In the Define Configuration window select all Exchange SPI templates or
template groups, including any user-customized templates.

4. Click Remove Templates.

5. Click OK.

REMOVING EXCHANGE SPI FROM MANAGED NODES

1. Select Actions: Agents>Install/Update SW & Config from the menu bar.
2. Check the following checkboxes to select these components for removal:

B Templates
W Actions
B Monitors
B Commands
3. Click the Nodes in List Requiring Update button.

4. Ifyou did not select a node previously, click the Get Map Selections button
to list the target node(s).

5. Click the Force Update button.
6. Click OK. The following message appears in the message browser:

The following configuration information was successfully
distributed:
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Templates Actions Commands Monitors
The Exchange SPI templates and software have now been removed from the
selected managed node(s). The Exchange SPI templates still reside in the OVO

data repository and must be deleted manually. Continue with Deleting
Templates, Applications and Message groups chapter 3 page 83.

DELETING TEMPLATES, APPLICATIONS AND MESSAGE
GROUPS

Exchange SPI templates, and certain applications (EXSPI admin group) and
message groups (EXSPI EX Perf and EX Fault) must be deleted manually.

1. To delete the Exchange SPI Message Source templates, select Window:
Message Source Templates from the menu bar.

2. Open all Exchange SPI template groups and use SHIFT+click to select all
templates for deletion.

3. Select Delete from All to delete the templates.

4. Click Yes to the message: Do you really want to delete the
template(s)?

5. To delete from the EXSPI messages group, from the menu bar select
Window>Message Group Bank.

6. Select the EXSPI EX_Perf and EX_Fault message groups.
7. From the menu bar select Actions>Message Group>Delete.

8. Click Yes to the message: Do you really want to delete the
message groups?

9. To delete any Exchange SPI application groups and their contents, select
Window: Application Bank from the menu bar.

10. Select all Exchange EXSPI Admin Applications and Graphs.
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11. From the menu bar select Action>Application>Delete.

12. Click Yes to the message: Do you really want to delete the
application groups.
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Introduction

Like all HP OpenView SMART Plug-Ins, the Exchange SPI is easy to use. This
chapter describes some special usage features and functionality, including:

Q Daily Tasks

O Exchange SPI template group requirements

Q Exchange SPI Service Discovery

O Using Exchange SPI Service Views

Q Changing the OpenView data collection agent setup

O Command Line Parameters
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Daily Tasks

A daily task list for monitoring with the Exchange SPI follows:

1.

Use the OVO message browser to watch for warning and critical messages
or multiple alarms. Read the associated instruction text.

Adjust alarm thresholds if too many alarms are being generated (see
“Customize the Threshold” later in this chapter).

Use the OVO graphing and reporting applications to drill down for
additional information, or to view history or trends.

Check the active Message Browser frequently. Note the message group a
metric belongs to:

B EXSPI Messages generated by EX-SPI programs.They contain
instruction text to help to diagnose/remedy problems.

B EX Perf. Messages regarding performance.

B EX Fault. Messages regarding error conditions.

Click perform Action (if available) from the message or message
browser to automatically perform a pre-defined operator action. Click

Details from the message or message browser to view details of the set
action.
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6. Click Instructions from the message browser or the message itself to
read and follow suggested instructions to help diagnose/remedy problems
(see example below).

Sample Instruction Text from Exchange SPI Alarm Message

_l Instruction Qutput | . | Jl

Metric description: Monitors the average time between submission of a message to the
private information store and submission to the WTA for the last
10 messages
Counter: MSExchangelS Private. average Delivery Time

Probable cause(s): Delivery of messages to other Exchange servers may be delayed by the
MTé

Delay of messades being processed could indicate problems with system
Toad, the Information Store, or the MTA.

Fotential impact: Performance

Suggested action{s):

(1 Monitor system with Windows NT Task Managed or MT Performance Monitor to determine
if the system is overloaded. Also check that the MTA process (emsmta) is running.

(23 Check other messages in the ‘Message Browser' to see if Exchange has been reporting
problems with the MTA service on either the problem system or the remote system.

(3 Verify that there are no network problems.

(4> Enable Diagnostics Logging for the MT4 (using Exchange Administrator) to help in
troubleshooting.

Close Save... Help

7. Use MeasureWare Agent to export data if desired. Consult the
MeasureWare Agent User’s Guide for details.
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NOTE:

NOTE:

Exspi Template Group Requirements

Important Microsoft Information on the Web: Before you distribute Exchange
SPI templates, please refer to the Microsoft article “PRB: Performance Object Is
Not Displayed in Performance Monitor” at this URL:
http://support.microsoft.com/support/kb/articles/(0248/9/93.ASP. The article
contains information on editing the Windows registry so that performance objects
(tracked by Performance Monitor) are always enabled. A disabled performance object
could cause an Exchange SPI template to fail. By following the instructions in the
article, you can ensure that templates are able to collect Exchange performance data as
expected.

Some templates in the SPI for Exchange template groups require that particular
software components/services are installed on Exchange server systems before
the distributed templates will work, and some require the existence of a service
account with special Exchange privileges. To create such an account, see
Creating a Service Account with Proper Access Permissions chapter 2 page 22.

Use the following tables to decide which templates you want to install. In the
template prerequisites table you can see whether or not a template
group/subgroup works with Exchange 5.5, Exchange 2000 or Exchange 2003, as
well as any required configuration. Template Group Descriptions show you what
type of data/functionality the template group offers.

In OVO for UNIX version 8, templates are referred as policies.
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Table 1: EXSPI Template Group Prerequisites for Exchange 5.5

EXCHANGE 5.5 Required Required Manual Configuration
[Template Group/ Subgroup lslé(:‘tlizgge
EXSPI-55 Quick Start N/A N/A
EXSPI-55 Add-Ons cc:Mail Connector| N/A
EXSPI cc:Mail Connector
EXSPI Internet Mail Services Internet Mail N/A
Service (IMS)
EXSPI Lotus Notes Connector Lotus Notes N/A
Connector
EXSPI News Service N/A N/A

EXSPI-55 Advanced
EXSPI End to End Message Ping

Create MSXSPI service account with
correct permissions

Edit the MBOX Config Application to
contain User Password

Create mailbox using MBOX Config
application

Configure EXSPI End to End Message
Ping template to set up server pairs

Modify the template to include service
account and password

EXSPI Event Log Warnings &
Information

Use for troubleshooting

EXSPI Reporter Collection

Create MSXSPI service account and
password
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Table 2: EXSPI Template Group Prerequisites for Exchange 2000 and 2003

Exchange 2000 and 2003 Required Required Manual Configuration
Exchange

Template Group/ Subgroup Service

EXSPI-60 Quick Start N/A N/A

All templates

EXSPI-60 Add-Ons cc:Mail N/A
Connector

EXSPI cc:Mail Connector

EXSPI Chat Service (Exchange | Exchange Chat | N/A

2000 only) Service
EXSPI Conferencing Service Exchange N/A
(Exchange 2000 only) Conferencing

Server

EXSPI MCU Server (Exchange | MCU Server N/A

2000 only)
EXSPI Instant Messaging Exchange Instant| Some templates in this group must
(Exchange 2000 only) Messaging be modified to contain a service

Service account user name and password

EXSPI Lotus Notes Connector Lotus Notes N/A

Connector
EXSPI NNTP Network News | N/A
Transfer
Protocol (NNTP
Transaction Log Some templates in this group must

be modified to contain a service
account user name and password
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Exchange 2000 and 2003
Template Group/ Subgroup

Required
Exchange
Service

Required Manual Configuration

EXSPI-60 Advanced
EXSPI End to End Message Ping

N/A

For each node where the template is
to be distributed:

Create MSXSPI service account
with correct permissions

Edit the MBOX Config application
to contain User Password

Create mailbox using MBOX
Config application

Configure EXSPI End to End
Message Ping template to set up
server pairs

Modify the template to include user
account and password

EXSPI Event Log Warnings &
Information

N/A

Use for troubleshooting

EXSPI Reporter Collection

N/A

Create MSXSPI service account
and password
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Exchange SPI Service Discovery

The Exchange SPI contains an application and a Scheduled template, to discover
Exchange services on OVO managed nodes. The discovery process can be
initiated at any time by the EXSPI Discovery application running on the OVO
management server. The Scheduled template needs to be distributed on the
management server, out-of-the-box it is set to run once a week (on Saturday),
and discovers Exchange services

The service graph generated by the EXSPI Discovery is a snapshot of the
services on the managed nodes at the time at which the application is run. The
discovered Exchange topology is maintained in OVO and is made available in
the various dynamic Exchange maps and views.

The views of discovered services enable operators to see at a glance the current
operational status of their Exchange environment, and can help them to analyze
events in terms of their impact on the overall business service.
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Prerequisites for Exchange SPI Service Dis-
covery

B Exchange SPI service discovery requires that Windows Scripting Host
version 5.6 is present on the managed node. By default, this version is
present in Windows 2000/2003. Windows NT users should install the
WSH version 5.6 manually, before running Exchange SPI discovery.

B Exchange SPI service discovery requires the OVO Service Navigator,
this can be installed together with other OVO components at initial
OVO installation. For details on how to install it at a later date, refer to
the OVO Installation Guide.

B The machine where the OVO management server is installed should
also be a managed node of that management server, with the OpenView
Operations agent software installed and running successfully.
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Mechanism for gathering service information

The mechanism the Exchange SPI uses to gather service information is a simple
one: a discovery server on the OVO management server uses the list of managed
nodes as parameters to trigger a discovery client on each of the OVO managed
nodes listed. The discovery clients on the various OVO managed nodes use
discovery modules that are installed during the installation of the Exchange SPI
agent software, to gather information about the services present on the managed
nodes. The discovery server writes error messages to the following file:
/var/opt/OV/log/SPISvcDisc/discovery error.log
Tracing can be enabled on the Management server by turning ‘ON’ the
SPI DISC TRACE variable in the EXSPI_DiscConfig.sh file which is found
under:
/opt/OV/EXSPI/bin/
Trace files can be found on the management server under:
/var/opt/0V/log/SPISvcDisc/discovery trace EXSPI.log
The discovery client on the managed node writes generic error information into:

$0OvAgentDir%\log\SPISvcDisc\discovery.log

Apart from these files, EXSPI discovery errors can also be found in EXSPI error
log file:

$0OvAgentDir%\exspillog\exspierror.
If tracing is enabled, any tracing information can be found in:

$OvAgentDir$\exspil\log\trace
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The service configuration files compiled by the discovery process are written to
the directory on the management server using the following file-naming
conventions:

/var/opt/OV/SPISvcDisc/conf/EXSPI/EXSPISvcDisc <nodenames.xml

where nodename is the name of the node on which the discovery application has
been run.

The discovery server validates the syntax of the Service configuration file. If the
file is valid, discovery server activates the service file and assigns operators to
the Root service EXSPI. By default, the operator, opc_adm will be assigned. The
activated services can be viewed through Java GUI of OVO/Unix, when logged
as 'opc_adm'.

Turning off Discovery failure messages:
When Exchange SPI Discovery fails to discover services, failure messages are

sent to the OVO Management server. To turn off these messages, the user has to
modify the file EXSPI_DiscConfig.sh located in

/opt/OV/EXSPI/bin
on the Management server. The user has to change MSG_ ALLOW=Y to

MSG_ALLOW=N. (The default value is Y, which means the messages are
allowed).
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Performing Service Discovery using the
Exchange SPI application

1.

Select all the Exchange managed nodes you wish to configure in the VPO
Node Bank.

Drag and drop these nodes on the EXSPI Discovery application, located in
the EXSPI Admin application group, under the appropriate Exchange
version.

Check whether there are errors in the Output of the Application window.
A successful discovery displays messages as in the figure below:
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Output of Application window
.

Upon successful discovery, a message window will notify that a significant
change has occurred in the service configuration on the management server, and
it is necessary to reload the configuration and update the service map.
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TO RELOAD THE CONFIGURATION
1. Logon to the OVO Java GUI as the OVO Administrator (opc_adm)

2. Select File-> Reload Configuration.
3. A window will notify that the reload configuration is in progress.

4. View the updated service maps.

MANUAL UPDATE

Changes to the service configuration of a managed node do not appear
automatically in the SPI for Exchange Server service tree. In order to update the
contents of the SPI for Exchange Server service tree in the OV Service
Navigator, the Discovery application has to be run.
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Using Exchange SPI Service Views

The Exchange SPI integrates with the OpenView Service Navigator to provide
an additional perspective on the Exchange organization by offering Service
views. This feature is available only if the OpenView Service Navigator software
is installed and running and allows individual systems to be seen in terms of the
configured hardware, the installed software, and the operating system services
that are running.

Exchange SPI discovers Exchange services when the Exchange SPI application
EXSPI Discovery is run, and uses the discovered data to generate the service
SPI for Exchange Server tree. Example service views are shown in Exchange
5.5 Service Graph chapter 4 page 101, and Exchange 2000 and 2003 Service
View chapter 4 page 103.
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Exchange 5.5 Service Graph
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VIEWS ARE SNAPSHOTS

The service graph generated by the Exchange SPI is a snapshot of the services on
the managed nodes at the time at which the EXSPI Discovery application was
run. If the service configuration on a managed node subsequently changes, you
have to run the discovery process again to have the changes reflected in the
service tree.

CALCULATION AND PROPAGATION RULES IN DISCOVERY
PROCESS

Propagation rules for the objects in the SPI for Exchange Server tree are defined
by default as unchanged. This means that a parent service does not change the
status of a child object by, for example; attaching a priority to it. Such a scenario
would be feasible if a parent service considered the status of one child service to
be more important than the status of another child service.

Calculation rules for the SPI for Exchange Server tree are set by default to Most
Critical. This means that if a parent service has more than one child service, it
assumes the status equal to the highest severity of its child services. For more
information about calculation and propagation rules, as well as how to go about
modifying them, see the HP OpenView Service Navigator Concepts and
Configuration Guide.

OVO messages are associated with all the low-level services and, in addition,
the higher-level services: Exchange Information store and Exchange Messaging.
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Exchange 2000 and 2003 Service View
b Graph [Services] [ _|

Administrative Group: F... |

Connectaors Semrers

: = . -]
Y Y o
15475 54215
< 1]

Microzoft Exchange Ser... |

T

Microsoft Exchange Infu:-...l Microsoft Exchange Me... |
] ¢ [ %
i G,
I m'rri T
Microsaft Exchange I‘-.ﬂai...l Microsaft Exchange Pu... | Microsaft Exchange Qu... | hlicrosoft Exchange LinkS|

4-103



Chapter 4: Using the Exchange SPI
Changing the Data Collection Agent Setup

Changing the Data Collection Agent Setup

The HP OpenView Exchange SPI can detect whether or not you are using
OpenView Performance Agent (also known as MeasureWare Agent). If you are,
your new Exchange SPI installation will automatically use it as well. As a result,
if you use PerfView, your new installation also supports that configuration.

If for any reason you decide that you want to use the new HP OpenView
subagent included with OVO 7.0, you can configure managed nodes to do so.
Note that this configuration does not support PerfView.

To override the use of OpenView Performance Agent, set up an empty file
named nocoda.opt and store it on the managed node in a specific location. The
location will vary according to the managed node operating system as shown
below.

Managed Node O/S File Location

HP-UX and Solaris /var/opt/OV/cont/dsi2ddf/nocoda.opt

Windows \usr\ov\conf\dsi2ddf\nocoda.opt

To create the File:

1. (If necessary) on the managed node according to the path shown in the
preceding table, create the dsi2ddf directory.

2. Use a text editor to open a new file.

3. Save the file as nocoda.opt in the managed node’s dis2ddf directory.
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Command Line Parameters

The collector/analyzer executable exspi_e2k.exe can be used with the following

command line parameters:

Parameter

Description

-m <metric range>

-m (metric range) is used to specify the metric
number or range of metric numbers.

-t <tag>

-t (tag) allows the collector/analyzer to use a
different set of templates than those originally
provided with the Exchange SPI when collecting
metrics.

NOTE: Additional information about the tag
feature is found at the end of the “Customizing
Exchange SPI” section.

-p -m <range> [-v]

- p (print) executes specified metrics and prints their
values to standard output, for example:

<exspi_e2k.exe or exspi_e55.exe> -p -m 1-1001

-a -a directs the collector/analyzer to send the metric
value to OVO for alarm generating
-s -s executes the collector as the special service

account user (MSXSPI). Requires completion of the
advanced configuration (see Advanced
Configuration chapter 3 page 66).
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Parameter

Description

-1 -m <metric range>

-x <extended_option>

Data collection metrics start at 0500. Types:
Value: logs the actual value

Delta: logs the difference between current and
previous

Average: logs the average over a specific interval
(e.g. 1h)
where:

-1 collector logs data to logfile instead of reporting it
to OVO

-x <extended_option> is one of:

logtype: is either "value, delta, or avg"
logfreq: can only be "hourly" and is used only
with "avg"

runfreq: tells the collector the interval in seconds.
If the schedule interval of EXSPI is every 10
minutes, the runfreq option must be set to 10¥60 =
600: -x runfreq=600. The runfreq option can only be
used with "avg."

mbox: followed by "=<mailbox_name>" allows
specification of certain mailboxes with certain
metrics, specifically metrics:

611,612,622,623,630,631,632,640 and 641

Example of a command line using this option:
exspli -p -m 611 -x mbox=obrab
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Using Exchange SPI in high availability
environments

The Exchange SPI can be configured to accommodate cluster environments
where fail-overs allow uninterrupted Exchange availability.

Synchronized with the cluster environment, Exchange SPI monitoring can be
made to switch off for the failed node and switch on for the active node.

For recognizing clustered Exchange instances, Exchange SPI relies on XML
configuration files. These files allow the OVO agent to automatically enable

instance monitoring on the currently active node after disabling instance
monitoring on the inactive node.

The Exchange SPI setup for a cluster environment requires the following steps:
B Add the nodes to be managed.

B Modify, if necessary, the Exchange SPI monitoring configuration file
included with the Exchange SPI (msexchange.apm.xml).

B Create the clustered application configuration file (apminfo.xml) that
associates Exchange SPI-monitored instances (Exchange virtual
servers), with their corresponding cluster resource groups.

B Restart the agent on the managed node.

Step 1: Add the Exchange Cluster nodes to be managed.

Add the Exchange cluster nodes to be managed.

Step 2: Modify the Exchange SPI monitoring configuration file (if
necessary)

The Exchange SPI includes a monitoring configuration file,
(msexchange . apm.xml), which is an XML file that describes the templates
that should be cluster-aware.
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The (msexchange.apm.xml file works in conjunction with the clustered
application configuration file (apminfo.xml) that you need to create for
your Exchange cluster.

The purpose of the Exchange SPI msexchange . apm.xml file is to list all the
Exchange SPI templates on the managed node, in order that these templates can
be disabled/enabled, as appropriate, for inactive/active managed nodes.

The Exchange SPI msexchange . apm. xml file is normally ready to
use with no configuring. However, if you have renamed any templates,
you need to modify the file accordingly. The file is in the monitor
directory on the management server. After modifying this file, you
need to redistribute the monitors to the Exchange nodes that are part of
the Exchange cluster.

Step 3: Create the clustered application configuration file

Apminfo.xml isan XML file that describes the cluster instances (Exchange
virtual servers).

Apminfo.xml, working in conjunction with the Exchange SPI monitoring
configuration file (msexchange .apm.xml), allows you to associate
Exchange SPI monitored instances (Exchange virtual servers) with their
associating cluster resource groups. As a result, when a resource group is moved
from one node in a cluster to another node in the same cluster, monitoring stops
on the failed node and starts on the new node.

To generate the content of this file:
a. Launch the Exchange SPI Exchange Cluster Configuration application on an
Exchange cluster node, see ‘Exchange Cluster Configuration application” on
page 111.

b. Use the generated output to construct the apminfo.xml.

c. Save the completed apminfo.xml file on each node in the cluster in this
directory:

%0vAgentDir%\conf\OpC
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Step 4: Restart the agent on the managed node

After constructing and saving apminfo.xml, stop and restart the OVO agent
by running the following commands on each node:

opcagt -kill
opcagt -start

Example apminfo.xml file

The following is an example apminfo.xml file, where ExchResGroupl and
ExchResGroup2 are the names of the Exchange resource groups
corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances
(virtual servers):

<?xml version="1.0" ?>
<APMClusterConfigurations>
<Applications>
<Name>msexchange</Name>
<Instance>
<Name>EXCHVIRTSERV1</Name>
<Package>ExchResGroupl</Package>
</Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
<Package>ExchResGroup2</Package>
</Instance>

</Application>
</APMClusterConfiguration>
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EXCHANGE CLUSTER CONFIGURATION APPLICATION

Use the Exchange Cluster Configuration application to generate the content of
the apminfo.xml file. To execute this application:

Select all the Exchange managed nodes you wish to configure in the OVO

Node Bank.

Drag these nodes and drop them on the Exchange Cluster Config
application located in the EXSPI Admin > Exchange 2000 and 2003

application group.

Use the generated output to construct the apminfo.xml . For details,
refer to “Step 3: Create the clustered application configuration file” on

page 109).
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. Example output of Cluster Configuration application
¥ Dutput of Application Mo. 10

After constructing and saving apminfo.xml, you need to restart the agent on
the node, using the following commands:

Opcagt -kill

Opcagt -start
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DATA COLLECTION ON VIRTUAL SERVERS

In order for reports and graphs to show data for any nodes, appropriate data
collection templates need to be distributed to those nodes. See the section ‘Using
Exchange SPI Reports and Graphs” on page 138.

Run the Enable Message Tracking application on all nodes in the cluster before
distributing the EXSPI 6.0 Dc-TrackingLog Data template, so that the tracking
log reports will generate. The application must run on the physical nodes of a
cluster where the Exchange virtual server is running.

SEEING VIRTUAL SERVERS IN REPORTS AND GRAPHS

The Exchange SPI will show Exchange virtual servers in reports and graphs as
though they were physical Exchange servers.

SETTING UP END-TO-END MESSAGE PING ON AN
EXCHANGE CLUSTER

Using Exchange SPI, End-to-End Message Ping can be configured on Exchange
clusters.

1. Run the EXSPI MBox Config application on all nodes in the cluster. The
application must run on the physical nodes of a cluster where the Exchange
virtual server is running on. This is a necessary step for configuring and
distributing End-to-End Message Ping.

2. Follow the directions in Task 6. Set Up Message Ping server connections
and alarms chapter 3 page 73.
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EXCHANGE CLUSTER SERVICE MAP

Exchange clusters are represented in the Service Map, and Service map nodes
will be created in the service map for each Exchange virtual server in a cluster.

Messages for the Exchange virtual server show up under the Exchange virtual
server name in the maps.

For the Exchange Virtual server an EXSPI service discovery hosted-on hierarchy
is created within a Clusters container, which allows messages to be sent to the
hosted-on hierarchy.

This same hierarchy is also created as virtual nodes under the Exchange Virtual
Server. A dependency is created from each Virtual Exchange Server virtual node
to its corresponding Cluster hosted-on node. Messages and status will then
propagate up to the correct Virtual Exchange Server virtual node.
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Service map of clustered nodes

el

e Graph [Services]

Administrative Group: EI| Clusters
H
OWRMTTLCA

exchvitse el ow-exel v, |

1 2
e *
Meszaging owrntted a:5enmvices
b T
0
= 2L
il 3ilbas Databasel Publiz Falder Dratab aze Link“_:l Dueuel

S

5-115



NOTE:

NOTE:
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Using Exchange SPI in high availability environments

WHAT HAPPENS DURING A FAILOVER:

When a failover happens, dependencies to the failed node will be removed and
replaced with new dependencies to the newly active node. For example, if
EXCHVIRTSERV1 moves from OVRNTTCI1B to OVRNTTCI1A, the
dependencies to OVRNTTCI1B will automatically be removed and will be
replaced with a new set of dependencies to OVRNTTCIA..

When a failover happens, messages that occurred before the failover will not be
propagated to the virtual node

For this mechanism to work EXSPI-60-Exchange cluster discovery Event Log
template must be distributed.
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Chapter 6: Integrating Exchange SPI with Reporter

Introduction

Introduction

This chapter describes how to install and generate reports within Reporter from
Exchange SPI data. It contains the following sections:

Q Installing Exchange SPI reports

O Exchange SPI report template requirements

Q Table of data collection templates for reporting and graphing

O Exchange SPI report list

O Using Exchange SPI reports and graphs

Distributing the Quick Start data collection templates
Distributing Reporter Collection templates

Exchange SPI graphs

Deinstalling Exchange SPI Reporter templates
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Installing Exchange SPI Report Templates

To install Reporter reports on the system where Reporter is installed:

1.

Double-click EXSPI-Reporter.msi on the HP OpenView Operations for
Unix Application CD-ROM. This opens the EXSPI-Reporter InstallShield
Wizard.

Click Next on the welcoming dialog.

The next dialog confirms that EXSPI-Reporter is now installed, click Finish
to exit the wizard.

Open Reporter to see the SPI for Exchange folder under Reports.
Open the SPI for Exchange group of reports, and see the groupings of

Exchange reports. As you select each group, see in the details pane the
individual reports available in that group.
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Report Requirements

TEMPLATES TO DISTRIBUTE FOR EXCHANGE SPI REPORTS

Exchange SPI reports display data collected from EXSPI templates distributed to
Exchange servers.

In the table that follows, the location is relative to the folders SPI for Exchange \
Exchange 5.5 AND Exchange 2000 and 2003. Some templates are specific to
particular versions of Exchange, when this is the case the location is also specific
to this version, all other reports are relevant to all versions of Exchange.

The specific templates required for OVO to generate particular reports are as
follows:

Report Name Template Name Metric ID Location
Logged
(SUMMARY For
All Systems)
Exchange 2003 Dc-Mailbox IS Sum. Data| 610-611, 614, [ EXSPI Advanced
and 2000 System | Dc-Public IS Sum.Data | 620-621, \EXSPI Reporter
Information Dc-Exchange Info 623-624, 656 Collection
Summary
Exchange 2003 | Dc-Mailbox Data Exchange 2000 and 2003
and 2000 Top 100 630,632,633,634[ \EXSPI Advanced
Mailboxes 815 \EXSPI Reporter
Collection
Exchange SLA End to End Message Ping| 1002 EXSPI Advanced
Message Delivery \EXSPI End to End
Message Ping
Exchange System | Dc-Private/Mailbox IS [ 610-611, 614, | EXSPI Advanced
Information Sum. Data 620-621, \EXSPI Reporter
Summary Dc-Public IS Sum. Data | 623,624, 656 Collection
Dc-Exchange Info
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Report Name Template Name Metric ID Location
Logged
(SUMMARY For
All Systems)
Exchange Top 100 Dc-Mailbox Data 630-632 Exchange 5.5
Mailboxes \EXSPI Advanced
\EXSPI Reporter
Collection
Exchange Top 100| Dc-Public Folder Data | 640, 641 EXSPI Advanced
Public Folders \EXSPI Reporter
Collection
Exchange Dc-MTA Message 530-535 EXSPI Quick Start
Messaging Trends| Volume \EXSPI Message Transfer
for all Servers Agent
Dc-IS Private MsgVol OR| 540-543 EXSPI Quick Start
550-552 \EXSPI Information Store
Dc-IS Mailbox Msg Vol
Dc-IS Public Msg Vol
Dc-IMS Message Volume| 590-591 Exchange 5.5
\EXSPI Add-Ons
\EXSPI Internet Mail
Services
Dc-SMTP Message 670-675 Exchange 2000 and 2003
Volume \EXSPI Add-Ons
\EXSPI SMTP
Report Name Template Name Metric ID Location
(DETAIL-shows Logged
data grouped by
single systems)
Exchange 2000 | EXSPI-6.0 Dc-Chat 837-838 Exchange 2000 and 2003
Chat Trends Service Clients and \EXSPI Add-Ons
Channels.data \EXSPI Chat Service
Exchange 2000 | EXSPI-6.0 800, 810, 809, | Exchange 2000 and 2003
Conferencing Dc-ConfTrends.data 808 \EXSPI Add-Ons
Trends \EXSPI Conferencing
Service
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Report Name Template Name Metric ID Location

(DETAIL-shows Logged

data grouped by

single systems)

Exchange 2000 [ EXSPI-6.0 Dc-MCU 811-814 Exchange 2000 and 2003

MCU Trends \EXSPI Add-Ons
\EXSPI Conferencing
Service

Exchange 2000 | EXSPI-6.0 1d-Dc-Instant| 843 Exchange 2000 and 2003

Instant Messaging | Messaging \EXSPI Add-Ons

Users growth \EXSPI Instant
Messaging

Exchange 2000 [ EXSPI-6.0 lhr-Dc-Instant| 841, 845 Exchange 2000 and 2003

Instant Messaging [ Messaging DC \EXSPI Add-Ons

Auvailability and \EXSPI Instant

Usage Trends Messaging

Exchange 2003 EXSPI 6.0 Dc-Mailbox | 603,633,634, Exchange 2000 and 2003

and 2000 Inactive| Data 815 \EXSPI Advanced

Mailboxes \EXSPI Reporter
Collection

Exchange 2003 | EXSPI 6.0 Dc-Mailbox Exchange 2000 and 2003

and 2000 Mailbox| Data 630-632,634,815 \EXSPI Advanced

Details \EXSPI Reporter
Collection

Exchange 2003 EXSPI 6.0 Dc-Mailbox IS| 610-613, 624, | Exchange 2000 and 2003

and 2000 Mailbox| Sum. Data 630-632, 815 \EXSPI Advanced

Summary EXSPI 6.0 Dc-Mailbox \EXSPI Reporter

Data Collection

Exchange 2003 EXSPI-6.0 Dc-Mailbox | 610-613 Exchange 2000 and 2003

and 2000 Mailbox| IS Sum. Data \EXSPI Advanced

Usage Trends \EXSPI Reporter
Collection

Exchange 2003 Dc-Mailbox IS Sum. Data| 71, 614, 630, EXSPI Advanced\EXSPI

and 2000 Mailbox | & Dc-Mailbox Data 631, 632, 634, | Reporter Collection

Store Stats 815

Exchange 2003 Dc-Public IS Sum. Data &| 73, 624, 640, 641 EXSPI Advanced\EXSPI

and 2000 Public | Dc-Public Folder Data Reporter Collection

Folder Store Stats
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Report Name Template Name Metric ID Location
(DETAIL-shows Logged
data grouped by
single systems)
Exchange 2003 | Dc-Transaction Log 7 EXSPI Add-Ons\EXSPI
and 2000 Space Usage Transaction Log
Transaction Log
Stats
Exchange User Dc-User Connections 520-521 EXSPI Quick Start
Connections \EXSPI Services and
Processes
Exchange Folder | Dc-Public IS Sum. Data | 620-624, \EXSPI Advanced
Summary Dc-Public Folder Data 640-641 EXSPI Reporter
Collection
Exchange Folder | Dc-Public IS Sum. Data | 620-622 \EXSPI Advanced
Usage Trends EXSPI Reporter
Collection
Exchange IMS EXSPI-5.5 Dc-IMS 590-593 Exchange 5.5
Messaging Trends| Message Volume \EXSPI Add-Ons
\EXSPI Internet Mail
Services
Exchange Dc-Mailbox Data 630-632 \EXSPI Advanced
Mailbox Details EXSPI Reporter
Collection
Exchange Dc-Private/Mailbox IS 610-613, \EXSPI Advanced
Mailbox Summary| Sum. Data 630-632 EXSPI Reporter
Dc-Mailbox Data Collection
Exchange Dc-Private/Mailbox IS | 610-612 \EXSPI Advanced
Mailbox Usage | Sum. Data EXSPI Reporter
Trends Collection
Exchange Dc-MTA Message 530-535 EXSPI Quick Start
Messaging Trends| Volume \EXSPI Message Transfer
Agent
Dc-IS Private Msg Vol [ 540-543 EXSPI Quick Start
OR 550-552 \EXSPI Information Store

Dec-IS Mailbox Msg Vol
Dc-IS Public Msg Vol
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Report Name Template Name Metric ID Location

(DETAIL-shows Logged

data grouped by

single systems)

Dc-SMTP Message 670-675 Exchange 2000 and 2003
Volume \EXSPI Quick Start

\EXSPI General Data
Collection

Exchange Top Dc-TrackLog Data 662 EXSPI Advanced

Destinations \EXSPI Reporter
Collection

Exchange Top Dc-TrackLog Data 661 EXSPI Advanced

Recipients \EXSPI Reporter
Collection

Exchange Top Dc-TrackLog Data 660 EXSPI Advanced

Senders \EXSPI Reporter
Collection

Exchange Top Dc-TrackLog Data 663 EXSPI Advanced

Sources \EXSPI Reporter
Collection
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Data Collection for Graphing and Reporting

The Exchange SPI collects data for graphing and reporting through data
collection templates. Exchange and Windows data is collected, summarized, and
forwarded to the OVO data collecting agent. Reporter can be used to access the
data source EXSPI DATA and write reports using Seagate Crystal Reports.

Data is collected through the following data collection templates:

Table 1: Quick Start Data Collector Templates

Data Collector Scheduled
Name Times Metric IDs Table
Dc-SMTP Message Hourly 670: SMTP Server.Messages Sent Total EXSPI MULTI
Volume 671: SMTP Server.Messages Received Total

672: SMTP Server.Bytes Sent Total

673: SMTP Server.Bytes Received Total

674: SMTP Server.Message Bytes Sent Total

675: SMTP Server.Message Bytes Received Total

Note: These are running totals since the SMTP

service started. The Exchange SPI calculates a

delta value between readings and logs this value to

show message volume.
Dc-SMTP Message Hourly 50: SMTP Server.Categorizer Queue Length EXSPI MULTI
Queues 51: SMTP Server.Local Queue Length

52: SMTP Server.Local Retry Queue Length

53: SMTP Server.Messages Pending Routing

54: SMTP Server.Remote Queue Length

55: SMTP Server.Remote Retry Queue Length
Measurement Data Hourly Writes the EXSPI_SINGLE values to the datastore | EXSPI_SINGLE
Collector each hour.
Create Coda Data Every 10 Creates database source EXSPIDATA with n/a
Sources mins objects: EXSPI_SINGLE, EXSPI MULTI,

EXSPI M0660, EXSPI M0661, EXSPI M0662,
EXSPI M0663, EXSPI M1002,

EXSPI PFDETAIL, EXSPI MBDETAIL,
EXSPI_MBSUMMARY, EXSPI_PFSUMMARY,
EXSPI_TRANLOG, EXSPI_SRS
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Table 1: Quick Start Data Collector Templates

Data Collector Scheduled
Name Times Metric IDs Table
Dc-IS Msg Every 10 581: MSExchangelS Mailbox.Average Local | EXSPI MULTI
Delivery Time minutes Delivery Time (for each
(0,10,20,30 | 582: MSExchangelS Mailbox.Average Database
,40,50) Delivery Time instance)
583: MSExchangelS Public.Average Local
For hours: Delivery Time EXSPI SINGLE
6-18 584: MSExchangelS Public.Average (total over all
Weekdays Delivery Time Databases)
only Note: The average value over all samples
over all database instances in the hour is
*This must | logged to EXSPI SINGLE, while the
be average value over all samples is logged per
scheduled instance to EXSPI MULTI
every 10
mins
beginning
at the 0
minute.
Dc-IS Private Hourly 540: MSExchangelS Mailbox.Local EXSPI_ MULTI
Mailbox Msg Vol deliveries (for each
For hours: 541: MSExchangelS Mailbox.Messages Database
6-18 Delivered instance)
Weekdays 542: MSExchangelS Mailbox.Messages Sent
only 543: MSExchangelS Mailbox.Messages EXSPI_SINGLE

Submitted

544: MSExchangelS Mailbox.Message
Recipients Delivered

Note: These are running totals since the
STORE service started. The Exchange SPI
calculates a delta value between readings and
logs this value to show message volume.

(total over all
Databases)
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Table 1: Quick Start Data Collector Templates

Data Collector Scheduled
Name Times Metric IDs Table
Dc-IS Public Msg | Hourly 550: MSExchangelS Public.Messages EXSPI MULTI
Vol Delivered (for each
For hours: 551: MSExchangelS Public.Messages Sent Database
6-18 552: MSExchangelS Public.Messages instance)
Weekdays Submitted
only 553: MSExchangelS Public.Message EXSPI SINGLE
Recipients Delivered (total over all
Note: These are running totals since the Databases)
STORE service started. The Exchange SPI
calculates a delta value between readings and
logs this value to show message volume.
Dc-MTA & IS Every 10 570: MSExchangeMTA . Work Queue Length | EXSPI MULTI
Queue Lengths minutes less MSExchangeMTA .Deferred Delivery (for each
(0,10,20,30 | Msgs Database
,40,50) 571: MSExchangelS Mailbox.Send Queue instance)
For hours: Size
6-18 572: MSExchangelS Mailbox.Receive Queue | EXSPI _SINGLE
Weekdays Size (total over all
only 573: MSExchangelS Public.Send Queue Size | Databases)
*This must | 574: MSExchangelS Public.Receive Queue
be Size EXSPI_SINGLE
scheduled Note: The average value over all samples for MTA work
every 10 over all database instances in the hour is Queue Length
mins logged to EXSPI_SINGLE, while the
beginning average value over all samples is logged per
at the 0 instance to EXSPI MULTI.
minute.
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Table 1: Quick Start Data Collector Templates

Data Collector Scheduled

Name Times Metric IDs Table
Dc-MTA Hourly 530: MSExchangeMTA .Inbound Messages
Message Volume Total EXSPI SINGLE
For hours: 531: MSExchangeMTA.Outbound Messages
6-18 Total
Weekdays 532: MSExchangeMTA.Total Recipients
only Inbound
533: MSExchangeMTA.Total Recipients
Outbound

534: MSExchangeMTA.Inbound Bytes Total
535: MSExchangeMTA.Outbound Bytes
Total

Note: These are running totals since the MTA
service started. The Exchange SPI calculates
a delta value between readings and logs this
value to show message volume.

Dc-User Hourly 520: MSExchangelS.Active User Count

Connections For hours: 521: MSExchangelS.User Count EXSPI_SINGLE
7-18
Weekdays
only
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Table 2: Add-Ons Data Collector Templates

Data Collector | Scheduled Metric IDs Table

Name Times

Dc-Chat Data 30 minutes 837: Microsoft Exchange Chat Service.Clients EXSPI MULTI
Collection Weekdays only 838: Microsoft Exchange Chat Service.Channels

Dc-ConfTrends 30 minutes 800: MSExchangeCONF.Active Conferences EXSPI MULTI

For hours: 7-18

808: MSExchangeDcsMgr.Local Conferences
809: MSExchangeDcsMgr.Remote Conferences

Weekdays only 810: MSExchangeDcsMgr.Active MCUs
Dc-MCU 30 minutes 811: MSExchangeT120.Data Messages Received EXSPI MULTI
For hours: 7-18 812: MSExchangeT120.Data Messages Sent
Weekdays only 813: MSExchangeT120.KBytes Received
814: MSExchangeT120.KBytes Sent
Note: These are running totals since the
Conferencing service started. The Exchange SPI
calculates a delta value between readings and logs
this value to show message volume.
Dc-Instant Hourly 843: Number IM enabled users on Server EXSPI MULTI
Messaging
Enabled Users
Dc-Instant Hourly 841: MSExchangeIM Virtual Servers.Current EXSPI MULTI
Messaging Users Online
842: MSExchangeIM Virtual Servers.Current
Subscriptions
845: MSExchangeIM.Failed Requests/sec
846: MSExchangeIM.Rejected Requests/sec
Dc-SRS Data Hourly 112,113,114 EXSPI_SRS
Space Usage
Dc-Transaction Hourly 7: Log File Size EXSPI TRANSLOG

Log Space Usage

Free Space on Volume
Total Size of Volume
Percentage Free on Volume
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Table 3: Advanced Data Collector Templates

Data
Collector
Name

Scheduled
Times

Metric IDs

Table

Dc-Exchange
Info

Daily

655: Server
656: Site
657: Organization

EXSPI MULTI

Dc-Mailbox
Data

Weekly

630: Mailbox size (MB)
631: Number of messages
632: Storage Limit

634: Last logon date/time
815: Database Instance

EXSPI_MULTI And
EXSPI_DETAILS

Dc-Mailbox IS
Sum. Data

Daily

71: Physical DB size (EDB)

STM Size

EDB Free

STM Free

EDB Total

STM Total

Logical Size

Number of Mailboxes

Number of Messages
614: MSExchangelS Mailbox.Single Instance
Ratio

EXSPI_ MBSUMMARY

EXSPI_MULTI

Dc-Public
Folder Data

Weekly

73: Folder Size
624: Number of Messages

EXSPI MULTI

Dc-Public IS
Sum. Data

Daily

73: Physical DB size (EDB)
STM Size
STM Free
EDB Total
STM Total
Logical Size
Number of Folders
Number of Messages
624: MSExchangelS Public.Single Instance Ratio
640: Folder Size
641: Number of messages

EXSPI SINGLE

EXSPI_MULTI
EXSPI_PFDETAIL
EXSPI PFDETAIL
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Data Scheduled Metric IDs Table

Collector Times

Name

Dc-TrackLog Weekly 660: Email Senders EXSPI_MO0660

Data 661: Email Recipients EXSPI M0661
662: Email Destinations EXSPI_M0662
663: Email Sources EXSPI_M0663

End to End 15 minutes 1002: SLA values of: EXSPI M1002

Met SLA

Almost Met SLA

This schedule not only executes the sending of
messages it also logs the data to the data store.
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Reports for ALL Exchange versions

These reports gather data from all OVO managed Exchange servers, regardless
of version.

DETAIL REPORTS FOR ALL EXCHANGE VERSIONS

Exchange Folder Usage Trends: Contains graphs showing trends in
database size, number of messages and average size of public folders.
The trends are shown for the time period selected when the report is
generated.

Exchange Messaging Trends: Provides trend graphs showing
messaging volume for the Message Transfer Agent, Information Store
and SMTP server message volume.

Exchange Mailbox Usage Trends: Contains graphs showing trends in
database size, number of messages, and average size of mailboxes. The
trends are shown for the time period selected when the report is
generated.

Exchange Top Destinations: Identifies the top email destinations
(local, other Exchange sites, internet, gateway) for email being sent by
an Exchange server.

Exchange Top Recipients: Identifies the top recipients of email for an
Exchange server.

Exchange Top Senders: Identifies the top senders of email for an
Exchange server. Only email sent by users that have Exchange
mailboxes is counted. Email sent by clients such as Netscape and UNIX
that do not have a corresponding Exchange mailbox are not counted.

Exchange Top Sources: Identifies the top email sources (local, other
Exchange sites, internet, gateway) for email being received by an
Exchange server.
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®  Exchange User Connections: Provides a trend graph showing open
and active user connections for the selected Exchange server.

SUMMARY REPORTS FOR ALL EXCHANGE VERSIONS

B Exchange System Information Summary: Contains summary

information about the OS and Exchange versions, mailboxes and public
folders.

B Exchange Messaging Trends for All Servers: Provides trend graphs
showing messaging volume for the Message Transfer Agent, the
Information Store, the Internet Mail Service across all Exchange
servers, and the SMTP server messaging volume.

®  Exchange Message Delivery SLA (Service Level Agreement):
Provides a trend graph showing how message delivery, messages read,
and directory read service levels are being met across all monitored
connections.
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Reports for Exchange 2000 and 2003

DETAIL REPORTS FOR EXCHANGE 2000/2003 SERVERS

Detail reports provide information by system. One report is generated with a
section for each system. The content of each report is as follows:

Exchange 2000 Chat Trends: Provides averaged information on the
number of client chat connections and channels for hours of the day
over the time period indicated.

Exchange 2000 Conferencing Trends: Provides averaged information
on the number of conferences and active MCUs for hours of the day
over the time period indicated.

Exchange 2003 and 2000 Folder Summary: Provides summary
information about the public folders on the server.

Exchange 2003 and 2000 Folder Usage Trends: Contains graphs
showing trends in database size, number of messages and average size
of public folders. The trends are shown for the time period selected
when the report is generated.

Exchange 2003 and 2000 Inactive Folders: This report lists all the
folders on the server that have not been accessed. The report also lists
folders that have not been accessed in 20, 40 and 60 or more days.

Exchange 2003 and 2000 Inactive Mailboxes: This report lists all the
mailboxes on the server that have not been accessed. The report also
lists mailboxes that have not been accessed in 20, 40 and 60 or more
days.

Exchange 2000 Instant Messaging Availability Trends: Shows
instant messaging usage trends.

Exchange 2000 Instant Messaging Users Growth: Shows the number
of users that are Instant Messaging enabled over the time period
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indicated.

B Exchange 2003 and 2000 Mailbox Details: Provides detailed
information about the mailboxes on the server including summary
totals, size distribution, and top mail users.

®  Exchange 2003 and 2000 Mailbox Store Stats: Provides database
volume statistics for Mailbox Store database files, for each managed
Exchange Server. The report gives a snapshot of the volume usage, as
of the most recent data collection.

®  Exchange 2003 and 2000 Mailbox Summary: Provides summary
information about the mailboxes on the server including summary
totals, size distribution, and top mail users.

®  Exchange 2003 and 2000 Mailbox Usage Trends: Contains graphs
showing trends in database size, number of messages, and average size
of mailboxes. The trends are associated per storage group and are
shown for the time period selected when the report is generated.

®  Exchange 2000 MCU Trends: Provides averaged information on the
number of conferences and active MCU's for hours of the day over the
time period indicated.

®  Exchange 2003 and 2000 Public Folder Store Stats: Provides
database volume statistics for Public Folder Store database files, for
each managed Exchange Server. The report gives a snapshot of the
volume usage, as of the most recent data collection.

®  Exchange 2003 and 2000 Transaction Log Stats: Provides

information concerning usage and availability of storage, by and for the
Exchange Transaction log.

SUMMARY REPORTS FOR EXCHANGE 2000/2003 SERVERS

Summary reports show data for ALL Exchange 2000 and 2003 servers. The
content of each report is as follows
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®  Exchange 2003 and 2000 System Information Summary: Contains
summary information about the OS and Exchange versions, mailboxes
and public folders.

®  Exchange 2003 and 2000 Top 100 Mailboxes: Lists the top 100
mailboxes by disk space usage across all mailbox databases.

B Exchange Top 100 Public Folders: Lists the top 100 public folders by
disk space usage.
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Reports for Exchange 5.5 only

DETAIL REPORTS FOR EXCHANGE 5.5 SERVERS

Detail reports provide information by system. One report is generated with a
section for each system. The content of each report is as follows:

B Exchange 5.5 Folder Summary: Provides summary information about
the public folders on the server.

®  Exchange 5.5 Mailbox Details: Provides detailed information about
the mailboxes on the server.

®  Exchange 5.5 Mailbox Summary: Provides summary information
about the mailboxes on the server including summary totals, size
distribution, and top mail users.

®  Exchange 5.5 IMS Messaging Trends: Provides trend graphs showing
messaging volume for the Internet Mail Service.

SUMMARY REPORTS FOR EXCHANGE 5.5 SERVERS

Summary reports show data for ALL Exchange 5.5 servers. The content of each
report is as follows:

®  Exchange Top 100 Mailboxes: Lists the top 100 mailboxes by disk
space usage.

B Exchange Top 100 Public Folders: Lists the top 100 public folders by
disk space usage.
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Using Exchange SPI Reports and Graphs

Exchange SPI report and graph generation require that you complete the following:

» Distribute the Quick Start template group for data collection templates.

* Configure and distribute Exchange SPI reporter collection templates.

NOTE: Time Interval for Exchange SPI Reports or Graphs

Exchange SPI reports and graphs will not be available until data has been gathered
to the management server from the managed nodes. This occurs each night, so at
least one day of activity is needed for the reports to populate. Where a report or
graph type requires data from a Sat/Sun collection, those reports/graphs will require
a weekend to pass.

Distributing the Quick Start Template Group

In order to collect data for reports and graphs the General Data Collection templates
in the Quick Start template group need to be distributed.

For the procedure to distribute templates, see Task 8: Assign/Distribute Quick Start
Templates chapter 3 page 63.
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Configure/Distribute Reporter Collection
Templates

For any Exchange server system on which you would like to receive reports, you
need to distribute Exchange SPI templates from the EXSPI Advanced > EXSPI
Reporter Collection group.

To configure the Reporter Collection templates two steps are required:
1. Enable message tracking. This is a version specific procedure.

2. Distribute Reporter Collection templates.

1. ENABLE MESSAGE TRACKING

Exchange provides a message-tracking facility that stores processed
message information in a log file. Template EXSPI-60/55 Dc-TrackLog
Data collection template reads the log file created by enabling message
tracking. This template must be distributed to the appropriate managed
nodes to gather the information. For procedures outlining how to enable
message tracking on Exchange 2000 and 2003 servers using the enable
message tracking Exchange SPI application, see 4b: Enabling Message
Tracking for Exchange 2000 and 2003 chapter 3 page 70, and for Exchange 5.5
servers see 4a: Enabling Message Tracking for Exchange 5.5 chapter 3 page 68.

2. DISTRIBUTE REPORTER COLLECTION TEMPLATES

The reporter collection templates need to be distributed to any managed nodes
where data is to be collected for reporting and graphing. For the procedure to
distribute templates, see Task 8: Assign/Distribute Quick Start Templates chapter
3 page 63.
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Deinstalling Exchange SPI Reporter

Remove the Exchange SPI reporter in one of the following ways:
1. Using the Windows Start menu.
2. Using the EXSPI-Reporter InstallShield wizard.

Using the Windows Start menu:

1. Select Start > Settings > Control Panel > Add/Remove Programs.
2. Select EXSPI-Reporter.
3. Click Remove.

Using the EXSPI-Reporter InstallShield wizard.

1. Double-click EXSPI-Reporter.msi. This opens the EXSPI-Reporter
InstallShield Wizard. Click Next on the Welcome screen.

2. Confirm the next screen by clicking Remove.

3. The InstallShield Wizard has deinstalled EXSPI-Reporter. Click Finish.
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Exchange SPI Graphs

Exchange SPI comes with a set of preconfigured PerfView graphs. These graphs
require that OpenView PerfAgent (aka MW Agent) be running on the managed
node, see Exchange SPI Graphs chapter 6 page 141.

Open the Exchange 5.5, or 2000/2003 Graphs window in the version specific
Application Group

TO INVOKE GRAPHS:
1. Select relevant Exchange managed nodes in the VPO Node Bank.

2. Drag these nodes and drop them on the desired graph.

B
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Exchange SPI graphs are the same for each Exchange version, except the
Transaction Log file size graph is only for Exchange 5.5.

INFORMATION STORE

‘¥ Application Group: Information Store

Delivery: This graph shows hourly metrics for the average delivery times of
messages to Exchange Server private and public mailboxes.

Mailbox Usage: This graph shows Exchange Server Mailbox usage.
Mailbox Volume: This graph shows Exchange Server Mailbox volume.
Public Folder Usage: This graph shows Exchange Server Public Folder usage.

Public Folder Volume: This graph shows Exchange Server Public Folder
volume.

Users: This graph shows information store user count metrics for the current
day.
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MESSAGING

‘¥ Application Group: Messaging

Internet Mail Queue: This graph shows the Exchange Server Internet Mail
Service queue count.

Internet Mail Volume: This graph shows Exchange Server Internet Mail
Connector volume.

MTA Volume: This graph shows Exchange Server Message Transfer Agent
volume.

Newsfeed Volume: This graph shows Exchange Server newsfeed volume.

Queues: This graph show Exchange Server queue lengths.
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SYSTEM INFORMATION

System Information for the following areas of performance are made available in
graph format:

®m NT CPU

m  NT Disk

®  NT History
B NT Memory

B NT Network

TRANSACTION LOG DISK SPACE (EXCHANGE 5.5 ONLY)

This graph shows Transaction Log Disk Space usage on Exchange 5.5 servers.
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NOTE

Generating Graphs from an Exchange SPI DSI
Logfile

PerfView graphs require an OVO agent to be running on the targeted
management server. You can generate PerfView graphs from the Exchange
version specific Exchange SPI Application Group window, and then opening the
Exchange 5.5, or 2000/2003 Graphs window. Graphs display the metric data
collected by the Exchange SPI data collector.

In addition, data from any Exchange SPI server can be graphed using PerfView
and data from Exchange SPI Measure Ware DSI logfiles.

Simple instructions for generating the graph follow. Additional information on
using PerfView can be obtained from the PerfView User Guide.

1. Open a terminal window and log on.

2. In the terminal window, to verify that the DISPLAY environment variable is
set to your terminal window, enter:

echo $DISPLAY

If the DISPLAY environment variable is not set correctly, set it to your
terminal window.

3. To start PerfView, type:
pv

The main PerfView window is displayed.

Since values are logged hourly to MeasureWare, use the PerfView Graph:
Settings->Points Every to set the time setting to 1h or 3h.
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10.

11.

12.

Select Data Sources>Manage.

In the PerfView Systems window highlight the desired system from the list
and click Open.

The Data Sources window is displayed listing all known source files. If the
desired data source is not listed, press Select and enter the data source name.

Select the desired source file from the list and click Open.

Perfview connects to the data source and displays it in the main window.
Select Graphs>Create New Graph.

In the Select Metrics window highlight the data source file.

A list of metrics is displayed to use for graphing.

Highlight the desired metrics from the list to use for graphing.

The selected metrics are displayed in the Metrics to Be Graphed portion of
the Select Metrics window.

Click OK when finished selecting metrics.

Click Draw to generate the graph.

You can use the Settings menu on the PerfView Graph window to change
settings for the graph, the Show menu to drill down to examine points on

the graph, and the File menu to save, print, or export the graph. You can
also correlate operating system metrics with Exchange SPI metrics.
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Introduction

This chapter outlines the following customization procedures:

B Choosing metrics to monitor Exchange
B Customizing the Exchange SPI
B Basic Customization procedures

*Creating custom groupings
*Creating custom templates
*Modifying message generation
*Modifying metric template conditions
*Customizing the Threshold
*Customizing Schedules

*The Tag Feature

B Advanced Customization procedures
*Changing the Windows User Account Name
*Changing the Mailbox Name

B Returning to original factory settings
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Choosing metrics to monitor Exchange

Before beginning customization, first decide which metrics can remain without
changing the thresholds, (see “Exchange SPI Metric Specifications” later in this
chapter or the Exchange SPI Reference Manual).

NOTE It is recommended that you make a copy of the original template group and use
the copy for customization purposes
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Basic Customization

Creating Custom Groupings

Create custom template groups as follows:

1. Logonto OVO as the OVO Administrator.

2. Select Window>Message Source Templates.

3. In the Message Source Templates window select the desired template group
and click the Add... button (if Add Logfile... is displayed, pull down the
list and select Add Group) and select a name and description for this group.

4. To copy templates to the new group:

B In the Message Source Templates window, double-click to open the
group containing the desired templates.

B Select the templates to copy and choose Edit>Copy from the Message
Source Templates menu to copy the templates.

B Return to the newly created template group and choose Edit>Paste
from the menu.
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Creating a New Template Group

dd Template Grou

_Template Group Name
EADM—Advanced Configuratior

_Descriptiun
§Eus admin Advanced Configuration Groug]

0K Cancelé Help

Creating Custom Templates

You can create a custom template by copying an original template, making any
desired changes, and saving it with a new name.

When the OVO environment scales, the Exchange SPI tag feature provides a
way to partition templates into groups with each group customized in a specific
manner.

Modifying Message Generation

Alarms are generated with Reset, without Reset or Continuously.
To change the Metric Generation Type (usually in conjunction with the
Threshold, Polling Interval and Reset value) follow these steps:
1. Select the Message Source Templates window.

2. Double-click to open the template group containing the metric to modify.

3. Click the Modify button.
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Modifying Message Generation

Hudi= Trorezlcle Honi oo

E¥ISPI [ E TaL 1t

4. Select one of the Message Generation types:

with Reset: Alarms are generated after the monitoring threshold has
been exceeded. No additional alarms are generated until metrics drop
below a specified Reset threshold and subsequently exceed the
monitoring threshold.

without Reset: Alarms are generated after the monitoring threshold has
been exceeded. No additional alarms are generated until metrics drop
below the threshold and subsequently exceed it.

Continuous: Alarms are generated continuously when metrics exceed
the threshold.
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Modifying Metric Template Conditions

Modify metric attributes as follows.

1. Select the Message Source Templates window.

2. Double-click the template group containing the metric to modify.
3. Double-click the desired metric

4. Inthe Message and Suppress Conditions window select the condition to
modify and click the Modify button.

The Message and Suppress Conditions Window

arcs leiplales

5. The condition window displays.
The following attributes can be easily modified:

Threshold. Set the desired threshold.
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Reset. This is a limit under which the object's value must drop (or exceed for
minimum thresholds) to return the alarm state of the object to normal.
After an object's alarm state has returned to normal, a new message can
be issued if the monitored parameter again exceeds (or drops below for
minimum thresholds) the threshold value. Do not enter a value if you do
not wish to impose a reset limit. Note that you can enter a reset value
greater than the threshold value (or less for minimum threshold types),
which has the same effect as if you don't specify a reset value.

Duration. Most metrics are defined as Message Generate type without
Reset and without a Duration. Please consult the OVO Concepts
Guide or online Help prior to modifying this field.

Severity. Click the [Severity] button and select the desired severity
setting.

Message Text. Be careful not to modify any of the parameters in a message.
Parameters are surrounded by <> brackets and begin with $.

Actions. This field provides the ability to add custom programs. Two types
of actions are available:

W Operator initiated: These actions are only performed upon the

initiation of an operator.

BAutomatic: These actions are performed automatically when the
metric alarms.

Some metrics have an operator-initiated action which will display a graph if
PerfView is installed on the management server.
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Customizing the Threshold

Customize the threshold as needed. To do so, copy the existing condition to use
as the default, and modify the original condition to serve as the exception.
Follow these steps:

1. Double-click the metric you want to customize (for example,
EXSPI-60-0001).

1. Inthe Message and Suppress Conditions window select the desired
condition and select the Copy button to make a copy of the condition.

2. Enter a name for the condition; for example, EXSPI-60-0001.3.

3. Click OK to close EXSPI-60-0001.3. This will be the default condition.

4. Select the original condition, EXSPI-60-0001.1.

5. Click the Modify button to display the Condition window.

6. In the Object Pattern field, enter the desired characters to use for pattern
matching (see the OVO online help or the OVO Administrators Task Guide

for pattern matching syntax).

7. Click the Test Pattern Matching... button to test the pattern and verify
pattern matching (you must set up a match file first).

8. Change the value in the value in the Threshold field.

Testing Pattern Matching from the Condition Window

= Condition Test a ﬁ

Test Reference File
{:ADM E

OK Cancelé Help
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Customizing Schedules

Schedule templates define the schedule by which the collector/analyzer will
gather metric information. To modify a schedule template, follow these steps:

1.

Select Window>Message Source Templates and double-click the template
group containing the template to modify.

Double-click the desired template

In the Modify Scheduled Actions change any of the schedule information
or other parameters.

Click OK to close and save the changes.

Distribute the template to the desired managed node(s).
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Customizing a Schedule Template

EXSPI-55—15m-Tra tion Lod
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The Tag Feature

When servers are dedicated to specific sites or business units, you may find it
more effective if those servers do not all share the same set of Exchange SPI
templates. In such cases, the tag feature is useful in allowing you to change
existing templates and rename them. In this way you can associate template
assignments with specific servers and the areas with which they are associated.
For example, you might create a business administration group of templates and
tag those templates with “ADM-" or a branch office group and tag those with
“BR-.”

The tag feature allows you to create custom templates in a quick way. To
summarize the steps, you:

B Make copies of existing monitor templates that you want to modify.
B (optional) Modify the monitor template settings.

B Save each modified template under the same name with a prefix.

|

Enter each metric and - <prefix tag> after the collector/analyzer
command in the Program Monitor or MIB ID box of the schedule
template.

Using this method allows the collector/analyzer to recognize a set of templates
different from those originally provided with the Exchange SPI. This method
allows you to enlarge the single set of templates to adjust to differing conditions
among the servers you use.

To use this feature, make copies of the original Exchange SPI templates. The
names you give these new templates must contain a prefix with the original
template name. To tell the collector/ analyzer to use this new template rather than
the original template, specify the tag option on the schedule template command
line.

New collector templates can also be created in this way, for example:

exspi e2k -m 16 -t ADM-

In this case the new collector template is called "ADM-EXSPI-15min."
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Advanced Customization

Changing the Windows User Account name

A Windows user account, used for creating a mailbox, is referenced in the
EXSPI MBOX Config application. To change the account name, edit the EXSPI
Mbox Config application and change the user name setting. This application
requires a user with Exchange administrative privileges.

NOTE

Changing the Mailbox name

For all schedule templates in the template group EXSPI-60 Data Collection
(Adv), add -x <mailbox name> to the command which is executed under the
schedule. For example:

exspi e2k -1l-s -m 630,631,632 -x logtype=value -x
mbox=MSXSPI

The default mailbox MSXSPI <hostname> can be changed by supplying the
mailbox name to EXSPI MBOX Config:

Use the OVO Customized Startup to start EXSPI MBOX Config, and add
-m <mailbox name prefix> | - ou <organizational unit>|
to the Application Parameter box.

Do not add the domain before the user name. The user must be in the domain
where the Exchange Server is located, and cannot be a local user.
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CAUTION

Returning to original factory settings

To re-install all Exchange SPI templates, applications and message groups with
original factory settings, run the following command:

/opt/0OV/bin/OpC/opccfgupld -verbose -replace
/var/opt/0OV/share/tmp/OpC appl/EXSPI/exspiset

Any customization of the original templates will be overwritten.
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Introduction

This chapter offers troubleshooting suggestions for Exchange SPI. It includes the
following sections:

Verifying Software Installation on the Management Server
The Exchange SPI Error Log

Turning on/ Disabling Tracing

Common Errors

Verifying the MSXSPI account has the right privileges
Verifying Measure Ware Integration

Installing Old DSI Log Files

Advanced Configuration Template Failures

o000 o0o00O0o

Exchange Service Discovery errors
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NOTE:

Verifying Exchange SPI Installation on the
Management Server

This utility is not available for Sun Solaris.

1. To check the integrity of Exchange SPI files on the OVO management
server, run the following command:

/usr/sbin/swverify SPI-EXCHANGE-OVO
This command produces output similar to the following:

swverify.agent auto exit = false
swverify.agent timeout minutes = 10000
swverify.allow incompatible = false

swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify
swverify

.allow multiple versions = false
.autoremove job = false
.autoselect dependencies = true
.check contents = true

.check permissions = true

.check requisites = true

.check _scripts = true

.check volatile = false

.control lang = C

.enforce dependencies = true
.follow_controller = false

.log msgid = 0

.logdetail = false

.logfile = /var/adm/sw/swverify.log
.loglevel = 1
.mount all filesystems = true
.rpc_binding info = {

ncacn_ip tcp:[2121]
ncadg ip udp:[2121]

}

swverify.rpc timeout = 5
swverify.select local = true
swverify.target directory = /var/spool/sw
swverify.verbose = 1
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swverify.software = EXSPI
swverify.targets = /
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The Exchange SPI Error Log

Errors are forwarded to the browser and logged to:
\usr\OovV\exspi\log\exspierror
For example:

04/01/02 08:43:57 ERROR exspi(488) [colamain.cpp:333]:
EXSPI-60-40:

Exchange Server Software not installed on this system
(Check: SOFTWARE\Microsoft\Exchange\Setup). Unable to
perform collection!
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Turning on Tracing

If a problem occurs and you are asked to turn on tracing by the EX-SPI support
team, use the Enable EXSPI Tracing application for the relevant Exchange
version.

1. Select all the Exchange managed nodes you wish to configure in the OVO
Node Bank.

2. Drag and drop these nodes on the Enable EXSPI Tracing application
located in the EXSPI Admin application group under the appropriate
version.

3. Verify whether there are any errors in the QOutput of Application window.

Output of Application window

¥ Dtput of Application No. 10

8 -166



NOTE

Chapter 8: Troubleshooting
Turning on Tracing

DISABLING TRACING

For disabling the tracing, use Disable EXSPI Tracing.

The trace file will grow very large. It is advisable to leave tracing enabled only
long enough to recreate the problem, or in order to comply with HP support
instructions.
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Common Errors

1. When re-installing or upgrading Exchange Server, Exchange Setup program
shows errors.

Symptom: Exchange Server re-install or upgrade (e.g., new Service Pack),
the Exchange Setup generates error messages about DLLs that can't be
overwritten.

Solution: Stop OVO (opcagt -stop) and MeasureWare (mwacmd
stop), then retry the operation.

2. Schedule template fails with message:
EXSPI xxxxx Metric Collection failed.

Symptom: The scheduled command failed with an exit code other than 0.

Solution: This error sometimes occur if the system is rebooted just before
the collector/analyzer program was executed.

However, if this is not the case do the following: To find out more
information about the failure, modify the failing schedule template, check
the Send Output of Action check box and re-distribute templates again.

The browser message should now contain an annotation with more
information about the failure. Also, check the exspierror for more
information.

3. Error when distributing Exchange 5.5 ConfigFile templates to Windows
NT4 managed nodes.

Symptom: During ConfigFile template distributation to Windows NT
nodes, the following system error message box appears and the action fails:

OvCfgFile.exe - Entry Point Not Found. The procedure
entry point  1lc collate cp could not be located in the
dynamic link library MSVCRT.d1ll.
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Solution: The Windows managed node does not have the correct version of
the Microsoft C Runtime library MSVCRT.dIl installed on the managed
node (MSVCRT.dII is located in the system32 directory). Upgrade your
system by downloading and installing a newer version of MSVCRT.dII as
described in Microsoft Knowledge Base article Q259403 at:
www.support.microsoft.com/default.aspx?scid=kb; EN-US;q259403
Updating MSVCRT.dIl may require a reboot. Afterwards, restart the failed
ConfigFile-template distribution.
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Verifying MSXSPI account has right
privileges

In order to verify that you have created the MSXSPI account with the right
amount of privileges to run advanced metrics such as 5, 841, or 630, do the

following:

1. Log into your Exchange 2000 or 2003 server as MSXSPI user (in the
correct NT domain).

2. Open a DOS command prompt window.

3. cd to the directory where exspi collector is located (typically in
c:\usr\ov\bin\OpC\monitor)

4. Run the following series of commands:

exspl e2k.exe -m 5 -p
exspl e2k.exe -m 841 -p
exspl e2k.exe -m 630 -p

5. These will print the results to the screen.

6. If these executed properly and the correct results printed on the screen, your
MSXSPI account has the right permissions.
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Verifying MeasureWare Integration

To verify MeasureWare integration check the following:

1.

2.

Is the MeasureWare Agent installed on the Exchange server managed node?

Is the MeasureWare agent up and running (mwacmd status or
MeasureWare Agent application in RPM Tools Windows group)? There
should be TWO rep_server programs running. If not, re-start
MeasureWare Agent.

Verify MeasureWare Agent configuration.

Verify that perf1bd.mwc (e.g., in \rpmtools\data) contains
EXSPI DATA data source.

If not, re-run MW setup: First run, Disable Data Logging, wait for
MW to re-start, then run Enable Data Logging.

Verify that DSI logfiles were created in
\usr\exspildsillog\exspi log.EXSPI_ *

Check the timestamps of those files; they are updated when the data
collectors run.

Verify exspi_e2k.exe or exspi_ e55.exe data forwarding:

The collector/analyzer exspi e2k.exe or exspi e55.exe
specified in the schedule templates writes MeasureWare data to
\usr\exspi\dsi\*.dat only if the keyword Mmw oN is present in the
\usr\exspildefaults file (note, the defaults file has no file
extension.). Check the defaults file for the above keyword. If not
present, run EXSPI Add DataSource.

Check whether *.dat files are present in \usr\exspi\dsi.

Check timestamps of *.dat files.
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Advanced Configuration Template Failures

Symptom: The following data collectors fail and a critical message is
shown in the OVO browser:

®  EXSPI-60/55 Dc-Private IS Sum. Data
B EXSPI-60/55 Dc-Public IS Sum. Data
B EXSPI-60/55 Dc-Mailbox Data

B EXSPI-60/55 Dc-Public Folder Data

Solution: These collectors access Exchange directly and require MSXSPI
user and MSXSPI<hostname> mailbox.

Verify MSXSPI user, MSXSPI<hostname> mailbox, MSXSPI rights in
Exchange and MeasureWare:

1. Verifty MSXSPI user setup.

B Use Windows User Manager to verify MSXSPI account. The user must
exist in the same domain as the Exchange Server is part of. Note: there
must be no local MSXSPI user.

®  For Exchange 5.5, the MSXSPI user must be part of Domain Admin
group.

2. Verify MSXSPI rights in Exchange.
The MSXSPI user must have "Receive As" and "Send As" Exchange
Admin permissions. See Creating a Service Account with Proper Access
Permissions chapter 2 page 22.

3. Verify MSXSP1I<hostname> mailbox.

Use Exchange Admin to verify that a MSXSPI<host name> mailbox exists
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and click on Recipients. In the right pane, a MSXSPI<host name> user
must show up for each server which belongs to the site.

Verify MeasureWare Agent integration as described in Verifying
MeasureWare Integration chapter 8 page 171.
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Exchange Service Discovery Failures

Symptom: The error message: Error: Specified file was not
found

Solution: Verify whether the distribution of Exchange SPI commands was
successful. Refer to Task 6. Distribute Exchange SPI actions, commands,
monitors chapter 3 page 59 for more details.

Symptom: Exchange SPI service discovery fails.

Solution: The following patches allow more than one instance of
'opctranm':

PHSS 28148 - OVO A.07.12 HP-UX 11.0/11.11

ITOSOL 00183 - OVO A.07.12 Solaris

If you do not have these, or the patches that supersede them, the Exchange
SPI discovery may fail if there is an instance of opctranm running already.
To resolve this, wait till the opctranm job is completed before starting the
Exchange SPI discovery (or) kill the opctranm process.

Symptom: The error message: Problem in Executing opcservice

Solution: Check if the OVO Service Navigator Component is installed.
Note: This component is included with the OVO bundle, on the CD.
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Introduction

This chapter lists the Exchange SPI file names, along with their descriptions,
owners, groups, and permissions. Exchange SPI files are grouped as follows:

O Management server files

0O Management server/managed node files
Q Managed node files

Q Logging and trace files
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Management Server Files

TEMPLATES FOR OPCCFGUPLD (OVO UPLOAD FACILITY)

All files listed in this table can be found on the management server in the
following directories (the location of these files varies by platform):

/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset/C/

Table 1: Management Server Files

File

Description

exspiset.idx

OVO upload control file. This
file defines what is being
uploaded into OVO: message
groups, monitor templates, logfile
templates, applications and
template groups.

TEMPLATES/LOGFILE
/logfile.dat

Definition file for logfile
encapsulation.

TEMPLATES/MONITOR
/monitor.dat

Definition file for OVO
templates: collector/analyzer
program, external monitor for
each metric and file system
monitor. Contains all details for
monitoring all metrics.

TEMPLATES/SCHEDULE
/schedule.dat

Definition file for Exchange SPI
schedule templates.

TEMPLATES/TEMPLGROUP
/templgrp.dat

Definition file for OVO template
group structure.

TEMPLATES /MSGGROUPS
/msggrps.dat

Definition file for OVO message
group structure.

TEMPLATES/INTERFACE
/msgi.dat

Definition file for Exchange SPI
specific error message.
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MISCELLANEOUS MANAGEMENT SERVER FILES

Table 2: Miscellaneous Other Management Server Files

File

Description

/etc/opt/OV/share/conf
/OpC/mgmt_sv/
reports/exspi_lc.sql

Report that lists all nodes that have
Exchange SPI templates assigned (for
license check).

/opt/OV/EXSPI/bin/exspipv

Script to run PerfView as metric operator
actions and bring up graphs.

/opt/OV/EXSPI/bin/exspircfg

Script for EXSPI Node Config.

/opt/OV/EXSPI/bin/EXSPI_DiscConfig.sh

Script for setting Exchange SPI related
variables.

/opt/OV/EXSPI/bin/exspipngcfg_e55.sh

Script for End-to-End Ping config for
Exchange 5.5

/opt/OV/EXSPI/bin/exspipngcfg_e2k.sh

Script for End-to-End Ping config for
Exchange 2000 and 2003

A-178




Appendix A: File Names
Management Server/Managed Node Files

Management Server/Managed Node Files

When you run swinstall, the following monitor and command files are installed
on the Management Server. They are also installed on managed nodes when you
distribute monitors, commands and actions from the Management Server to the

managed nodes.

MONITOR FILES

On Management Server:

/var/opt/OV/share/databases/OpC/mgd node/customer/ms/

intel/nt/monitor/

On Managed Node:

\usr\ov\bin\OpC\monitor

Table 3: Monitor Files

File

Description

exspi e2k.exe

Exchange 2000/2003 SPI Collector/Analyzer
program.

exspl eb55.exe

Exchange 5.5 SPI Collector/Analyzer program.

msexchange.apm.xml

Template list for cluster fail-over

OVAMTLog2k.d1l1l

Tracking.Log access library for Exchange
2000/2003

OVAMTLog55.d11

Tracking.Log access library for Exchange 5.5

OVAMDa .dll LDAP access library
hpudm. txt Internal data file
NOTE: All files in Table 3: Monitor Files, are in compressed ".Z" format to improve

distribution performance.
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COMMAND FILES

Command files are located in the following directories:

Management Server:

/var/opt/OV/share/databases/OpC/mgd node/customer/ms/

intel/nt/cmds

Managed Node:

\usr\ov\bin\OpC\intel\cmds

All files in this table are in compressed ".Z" format to improve

distribution performance.

Table 4: Command Files

File Description
exspicol.bat Turns data collection on selected node on/off (for
maintenance):
-vON
-v OFF
exspitra.vbs Turns EXSPI Tracing on/off
-v ON
-v OFF
exspimwd.vbs Turns data forwarding to MeasureWare on/off
(collector/analyzer will only forward data to
MeasureWare if set to on:
-v ON
-v OFF
exspimwc.exe Configures MeasureWare data collection.
exspidsc.bat MeasureWare configuration program
exspienc.exe For configuring managed node; part of the advanced

configuration.
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File

Description

exspi e2k cfg.vbs

For configuring an Exchange 2000 or 2003 server

mailbox.

exspi e55 cfg.exe

For configuring an Exchange 5.5 server mailbox.

exspiDDF.bat

For turning on data collection.

EXSPI_CODA m0660.spec/
EXSPI_MW m0660.spec
EXSPI_CODA m0661.spec/
EXSPI_MW m0661.spec
EXSPI_CODA m0662.spec/
EXSPI_MW m0662.spec
EXSPI_CODA m0663.spec/
EXSPI_MW m0663.spec
EXSPI_CODA ml002.spec/
EXSPI_MW m1002.spec
EXSPI CODA multi.spec/
EXSPI MW multi.spec
EXSPI_CODA_single.spec/
EXSPI MW _single.spec
EXSPI_CODA details.spec/
EXSPI MW details.spec
EXSPI_CODA pfdetail.spec/
EXSPI_MW pfdetail.spec

Data log specification

EXSPI DiscReg.txt

exspi discovery.wsf
exspi e2k discovery.vbs
exspi e55 discovery.vbs
exspi xmllib.vbs

Service Discovery related client side components

exspi e2k clust config.js

Generates xml output, which can be used for editing the

apminfo.xml file

exspi dbmount.vbs
(NOTE: This file is also present
under monitor and actions
directories) -

Checks and mounts dismounted information store(s)
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Windows Managed Node Files

MONITOR TEMPLATES
When templates are distributed from the management server to the Windows
managed nodes, the monitor templates are encrypted and stored in the following

directory:

\usr\Oov\conf\OpC\<hostname>\
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Logging and Trace Files

Logging and trace files are located in the following directory on the managed
node:

\usr\ov\exspillog

Table 5: Logging and Trace Files

File Description

trace When TRACE ON is setin \usr\OV\exspildefaults,
tracing and debug information is written to
\usr\OV\exspi\log. This file can get very large.

exspierror Error information when the Exchange SPI collector/analyzer
encounters an error condition. Messages written to this file are
also sent to the OVO message browser.
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Appendix B: Components

This appendix covers the Exchange SPI program components and contains the
following topics:

Q Component Interaction
O Table of Exchange 2000 and 2003 Templates
Q Table of Exchange 5.5 Templates

B -186



Appendix B: Components
Component Interaction

Component Interaction

The Exchange SPI consists of the following logical components:

Service discovery: When run, the EXSPI Discovery application discovers
Exchange services on OVO managed nodes and takes a snapshot, from this
information various views of the managed Exchange environment are
generated. This feature is available only if the OpenView Service Navigator
software is installed and running.

Template Groups with schedule and monitor templates: Monitor templates
define conditions for each metric, Schedule templates execute metrics
according to the defined schedule.

Collector/analyzer program: Collects the metrics specified in the templates at
predefined intervals, performs calculations, and forwards data to the OVO data
collecting agent. OVO checks the threshold values and triggers alarms.

Windows event log: Compares Windows event log entries against predefined
logfile templates, and forwards error messages to the OVO management
server.

EXSPI MBox Config: SPI application that configures an Exchange mailbox
for SPI to access mailbox and folder information (advanced configuration).

EXSPI Add DataSource: configures and starts the logging of data, Enable
Data Logging/Disable Data Logging: starts/stops data logging.

Graphs and reports: Can be generated using HP PerfView and HP Service
Reporter.

Persistent store: Saves metric specific values and reports between invocations
of the Collector/Analyzer.
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Component Interaction

Exchange SPI Component Interaction

Messages
{alertsierrors)

OVO Management
Server

Applications
EXSPI MBOX Config

OVO Managed
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Exchange SPI Templates

Installing the Exchange SPI adds the SPI for Exchange template folder to the
OVO console tree. Double click SPI for Exchange to display the Exchange
2000 and 2003, and Exchange 5.5 folders beneath. Double click to open either
folder, and see the EXSPI Quick Start, Add-Ons and Advanced template groups
for that version of Exchange. Selecting a template group in the console tree will
display the templates, or template sub-groups within that group, in the details
pane on the right.

MS EXCHANGE VERSION AND EXSPI PREFIX

This version of the Exchange SPI monitors MS Exchange 2003, 2000 and 5.5.
Template and Template group names contain the version number in the prefix,
where 60 refers to Exchange 2000 and 2003, 65 to Exchange 2003 only, and 55
to Exchange 5.5. For example, where an Exchange 5.5 template group has the
name EXSPI-55 Event Log Errors, the equivalent Exchange 2000 and 2003
template group is EXSPI-60 Event Log Errors.

When templates or template groups are referred to that work for both versions,
they are referred to in this guide as EXSPI-60/55 <template name>.

B -189



Appendix B: Components
Exchange SPI Templates

Section of Message Source Templates dialog

sage Source Templates 1 [opc_adm]

For a complete listing of templates with detailed template by template
specifications, see the HP OpenView Smart Plug-in for Microsoft Exchange
Server Reference Guide.
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Table of Exchange 2000/2003 templates

EXSPI-60 QUICK START

Exchange 2000 and
2003: Quick Start
Subgroups:

Templates

Descriptions

EXSPI-60 Cluster

EXSPI-60 Exchange Cluster Discover
SysLog

EXSPI-60 Exchange Cluster Discovery
AppLog

System Event Log for Cluster Events

Application Event Log for Cluster Events

EXSPI-60 Directory Sve
Access

EXSPI-60 DSAccess Appl Errors
EXSPI-60-0023

EXSPI-60-15m-DSAccess

MSExchangeDSAccess application event
log errors

Exchange DSAccess Cache Hit-Miss
Ratio

DSAccess Hit-Miss Ratio

EXSPI-60 Event Log
Errors

EXSPI-60-Exchange Application Errors

Templates in this group monitor Exchange
error messages written to the Windows
Event log file and when detected, forward
them to the OVO console

Exchange System Errors

EXSPI-60 General Data
Collection

EXSPI-60-Log Data (log single instance
data to OV Performance Agent)

Templates in this group create data stores
and write data to data stores

EXSPI-60 Information
Store

EXSPI-60-0030
EXSPI-60-0031
EXSPI-60-0032
EXSPI-60-0033
EXSPI-60-0034
EXSPI-60-0040

Templates in this group collect data on the
volume of messages processed by both the
Private and Public Information Store
during the last logging interval

IS Public Average Delivery Time

IS Public Average Local Delivery Time
IS Public Replication Queue Size

IS Public Receive Queue Size

IS Public Send Queue Size

IS Mailbox Average Delivery Time
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Exchange 2000 and
2003: Quick Start
Subgroups:

Templates

Descriptions

EXSPI-60 Information
Store (cont)

EXSPI-60-0041

EXSPI-60-0042
EXSPI-60-0043
EXSPI-60-0100
EXSPI-60-05m-IS

EXSPI-60-15m-IS

EXSPI-60-DC-IS Msg Delivery Time
EXSPI-60-DC-IS Mailbox Msg Vol
EXSPI-60-DC-IS Public Msg Vol
EXSPI-60-IS_DbLogRecordStallsPerSec|
EXSPI-60-IS DbLogThreadsWaiting
EXSPI-60-IS DbLogWritesPerSec
EXSPI-60-IS RPCOperations
EXSPI-60-IS_RPCRequest

EXSPI-60 Dc-Information Store

IS Mailbox Average Local Delivery Time

IS Mailbox Receive Queue Size
IS Mailbox Send Queue Size
IS User Connection Count Low

5m Scheduler for metrics in Information
Store group

15m Scheduler for metrics in Information
Store group

Collect data on the average msg delivery
times in core procs

Collect data on the vol. of messages
processed by Private IS

Collect data on the vol. of messages
processed by Public IS

Alarm on Information Store Transaction
Log Record Buffer Addition Stalls

Alarm on Information Store Threads
Waiting to Write to Transaction Log

Alarm on the number of times the
transaction log buffers are written

Alarm on number of MAPI client RPC
operations/sec

Alarm on number of MAPI client RPC
requests

Log RPC requests and operations/sec
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Exchange 2000 and
2003: Quick Start
Subgroups:

Templates

Descriptions

EXSPI-60 Services and
Processes

EXSPI-60-Connector State

EXSPI-60-Link State
EXSPI-60-Queue State
EXSPI-60-Server State
EXSPI-60-0001

EXSPI-60-0002
EXSPI-60-05m-Serv. & Processes

EXSPI-60-1001
EXSPI-60-10m-Serv. & Processes

EXSPI-60-DC-User Connections

Templates in this group monitor Windows
Services for Exchange by checking to see
that Exchange services configured with
Automatic startup are running.

Examines the class
ExchangeConnectorState for condition
ISUP equal to false

Examines the class ExchangeLink for
thresholds on NumberOfMessages

Examines the class ExchangeQueue for
thresholds on NumberOfMessages

Examines the class ExchangeServerState
for condition ServerState not equal to
good.

Process Monitor
Inactive Process Monitor

5m Scheduler for metrics in Services and
Processes group

Services Monitor

10m Scheduler for metrics in Services
and Processes group

Collect data on the number of users

EXSPI-60 Internal
Errors

EXSPI-60-Messages

Templates in this group collect information
on errors occurring within the Exchange
SPI and contains instruction text for fixing
common problems
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Table of Exchange 2000/2003 templates

Exchange 2000 and Templates Descriptions
2003: Quick Start
Subgroups:
EXSPI-60 Message Templates in this group collect data on the
Transfer Agent length of message queues and volume of

EXSPI-60-0010
EXSPI-60-0011
EXSPI-60-0012
EXSPI-60-0013
EXSPI-60-0014
EXSPI-60-0015
EXSPI-60-0016
EXSPI-60-0017
EXSPI-60-05m-MTA
EXSPI-60-1h-MTA
EXSPI-60-DC-MTA & IS Queue Len.

EXSPI-60-DC-MTA Message Volume

messages (number and kilobytes)
processed by the Message Transfer Agent.
Also collect data on failed, delayed, and
rejected inbound/outbound associations
and messages during the last logging
interval

MTA Message Delay

MTA Work Queue Length

MTA Failed Conversions

MTA Connection Message Delay

MTA Connection Queue Lengths

MTA Failed Outbound Associations
MTA Rejected Inbound Associations
MTA Rejected Inbound Messages

Sm Scheduler for metrics in MTA group
1h Scheduler for metrics in MTA group
Collect data on the length of message

queues in core procs

Collect data on the vol. of messages
processed by MTA
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Exchange 2000 and
2003: Quick Start
Subgroups:

Templates

Descriptions

EXSPI-60 SMTP

EXSPI-60-0050
EXSPI-60-0051
EXSPI-60-0052
EXSPI-60-0053
EXSPI-60-0054
EXSPI-60-0055
EXSPI-60-0056
EXSPI-60-0057
EXSPI-60-1h-SMTP
EXSPI-60-5m-SMTP
EXSPI-60-DcSMTP Message Queues

EXSPI-60-DC-SMTP Message Volume

Templates in this group monitor the
SMTP queue length, Non-Delivery
Reports (NDRs), and refused connections

SMTP Categorizer Queue Length

SMTP Local Queue Length

SMTP Local Retry Queue Length

SMTP Messages Pending Routing

SMTP Remote Queue Length

SMTP Remote Retry Queue Length
SMTP NDR Percentage

SMTP Outbound Connections Refused
1h Scheduler for metrics in SMTP group
5m Scheduler for metrics in SMTP group

Populate Node database with queue
metrics for graph.

Collect data on the volume of SMTP
messages processed.
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EXSPI-60 ADD-ONS

Exchange 2000 and Templates Descriptions
2003: Add-Ons
Subgroup
EXSPI-60 CC:Mail Templates in this group monitor the
Connector number of messages awaiting delivery to

EXSPI-60-0090
EXSPI-60-0091
EXSPI-60-0092
EXSPI-60-0093
EXSPI-60-1h-ccMail Connector

EXSPI-60-5m-ccMail Connector

Exchange from Lotus cc:Mail, the rate at
which Non-Delivery Reports (NDRs) are
being sent from Lotus cc:Mail to
Exchange and vice versa

cc:Mail MTS-IN Queue Length
cc:Mail MTS-OUT Queue Length
Exchange NDRs to cc:Mail
cc:Mail NDRs to Exchange

1h Scheduler for metrics in cc:Mail
Connector group

5m Scheduler for metrics in cc:Mail
Connector group

EXSPI-60 Chat Service
(Ex 2000)

EXSPI-60-0830

EXSPI-60-0831

EXSPI-60-0833

EXSPI-60-0834

EXSPI-60-0835

EXSPI-60-0836

Templates in this group monitor numbers
of clients logged onto chat community,
and note authentications, failures and
disconnections related to client timeouts,
DNS lookup requests and DNS lookup
failures

Microsoft Exchange Chat Service.Active
DNS logon threads

Microsoft Exchange Chat Service.Client
Timeout Related Disconnects

Microsoft Exchange Chat
Service.Anonymous Clients

Microsoft Exchange Chat
Service.Authenticated Clients

Microsoft Exchange Chat
Service.Authentication Failures

Microsoft Exchange Chat Service.Server
operations queued
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Exchange 2000 and
2003: Add-Ons
Subgroup

EXSPI-60 Chat Service
(Ex 2000) (cont.)

Templates

EXSPI-60-15m-Chat

EXSPI-60-Dc-Chat Data Collection

Descriptions

15m Scheduler for Chat Metrics

Collects data about Exchange Chat
Service clients and channels.

EXSPI-60 Conference
Svr (Ex 2000)

EXSPI-60-0800

EXSPI-60-0801

EXSPI-60-0802

EXSPI-60-10m-Conf
EXSPI-60-DC-ConfTrends

Exchange SPI monitors and reports on the
Conferencing Management Service, Data
Conferencing Service, Multipoint Control
Units (MCU) Server, Video Conferencing
Service, and Conferencing Bridge
Service. These services are offered with
Exchange 2000.

MSExchangeCONF.Active Conferences

MSExchangeDcsMgr.DCOM Calls To
MCUs

MSExchangeDcsMgr.Average Load Per
MCU

10m Scheduler for active conferencing

Collect data on trends in conferencing

EXSPI-60 Conferencing
Bdg (Ex 2000)

EXSPI-60-0805

EXSPI-60-0806
EXSPI-60-0807

EXSPI-60-10m-ConfBridge

Exchange SPI monitors and reports on the
Conferencing Management Service, Data
Conferencing Service, Multipoint Control
Units (MCU) Server, Video Conferencing
Service, and Conferencing Bridge Service

MSExchangelpconf.Failed User Join
Attempts

MSExchangelpconf.Video Conferences in
Progress

MSExchangeH323.Incomplete Calls

10m Scheduler for failed user join
attempts and video conferences in
progress

EXSPI-60 MCU Server
(Ex 2000)

EXSPI-60-0803

Templates in this group monitor and
collect data on the MCU service

MSExchangeT120.Active Connections
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Exchange 2000 and
2003: Add-Ons
Subgroup

Templates

Descriptions

EXSPI-60-0804
EXSPI-60-10m-MCU

EXSPI-60-DC-MCU

MSExchangeT120.T120 MCU Load

10m Scheduler for MCU conferencing
trends

Collect data on MCU conferencing trends

EXSPI-60 Instant Msg
(Ex 2000)

EXSPI-60-0841
EXSPI-60-0842

EXSPI-60-0845
EXSPI-60-0846
EXSPI-60-1d-Instant Messaging DC

EXSPI-60-Instant Messaging DC

Templates monitor numbers of current
users online, current subscriptions for
each virtual service instance, and message
processing time

MSExchangeIM Virtual Servers.Current
Users Online

MSExchangeIM Virtual Servers.Current
Subscriptions

MSExchangeIM.Failed Requests/sec
MSExchangeIM.Rejected Requests/sec

Reporting Collection for Instant
Messaging

Alarming metrics for Instant Messaging

EXSPI-60 IPC
(Exchange 2000 only)

EXSPI-60-EpoxyClientOutQueueLength

EXSPI-60-EpoxyStoreOutQueueLength

Alarm on epoxy client out queue length

Alarm on epoxy store out queue length

EXSPI-65 IPC
(Exchange 2003 only)

EXSPI-65-EpoxyClientOutQueueLength

EXSPI-65-EpoxyStoreOutQueueLength

Alarm on epoxy client out queue length

Alarm on epoxy store out queue length
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Exchange 2000 and
2003: Add-Ons
Subgroup

Templates

Descriptions

EXSPI-60 IS Virtual
Memory

EXSPI-60-0025
EXSPI-60-IS VMLargestBlock

EXSPI-60-IS VMTotall6MBFreeBlock
s

EXSPI-60-IS VMTotalLargeFreeBlock

EXSPI-60-2h-IS VM Total Free Blocks

Monitors total number of free virtual
memory blocks regardless of size

Monitors the size (in bytes) of the largest
free block of virtual memory

Monitors total number of free virtual
memory blocks that are greater than or
equal to 16 MB

Monitors sum in bytes of all the free
virtual memory blocks that are greater
than or equal

Total number of free virtual memory
blocks regardless of size

EXSPI-60 Lotus Notes
Connector

EXSPI-60-0094

EXSPI-60-0095

EXSPI-60-0096
EXSPI-60-0097

EXSPI-60-1h-Lotus Notes Connect

EXSPI-60-5m-Lotus Notes Connect

Templates monitor number of messages
awaiting delivery to Exchange from Lotus
Notes, the rate at which Non-Delivery
Reports (NDRs) are sent from Lotus
Notes to Exchange and vice versa

Lotus Notes Inbound Queued Messages
Length

Lotus Notes Outbound Queued Messages
Length

Exchange NDRs sent to Lotus Notes

Lotus Notes NDRs sent to Microsoft
Exchange

1h Scheduler for metrics in Lotus Notes
Connector group

5m Scheduler for metrics in Lotus Notes
Connector group

EXSPI-60 Mailbox

EXSPI-60 Db Mounted Check

EXSPI-60-0070
EXSPI-60 Db Mounted Search

EXSPI-60-1h-Mailbox Space Usage

Events of application event log indicate
information store mounting/dismounting

Mailbox Database File Disk Space

Search an Exchange server for
dismounted information store(s)

Monitors mailbox store space usage
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Exchange 2000 and
2003: Add-Ons
Subgroup

Templates

Descriptions

EXSPI-60 NNTP

EXSPI-60-0058
EXSPI-60-1h-NNTP

Templates in this group monitor the failed
newsfeed connections

Newsfeed Outbound Connections Failed

1h Scheduler for metrics in NNTP group

EXSPI-60 Public Folder

EXSPI-60 Db Mounted Check

EXSPI-60-0072
EXSPI-60 Db Mounted Search

EXSPI-60-1h-Public Folder Space
Usage

Events of application event log indicate
information store mounting/dismounting

Public Folder Database File Disk Space

Search an Exchange server for
dismounted information store(s)

Monitors public folder store space usage

EXSPI-60 Site
Replication Service

EXSPI-60-0110
EXSPI-60-0111
EXSPI-60-05m-DS

Templates monitor site replication to
verify that synchronization updates are
being processed efficiently.

DS Pending Synchronizations
DS Remaining Updates

5m Scheduler for metrics in Directory
Service group

EXSPI-60 Transaction
Log

EXSPI-60-0004
EXSPI-60-0005
EXSPI-60-0006

EXSPI-60 Dc-Transaction Log Space
Usage

Templates monitor the size in MB of the
Exchange transaction logfiles as well as
the disk space used by the files.

Percent Low Log File Disk Space
Low Log File Disk Space
Transaction Log File Disc Space

Collects and logs transaction log space
usage activity

EXSPI-60 Virus Scan
(Exchange 2000 only)

EXSPI-60- Virus Scan Queue Length

EXSPI-60- Virus Scan Files Quarantined
per sec

Templates in this group monitor virus
scans for optimum performance

Checks Information Store Anti Virus API
Queue Length.

Checks Information Store Anti Virus API
of Files Quarantined/sec.
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Exchange 2000 and
2003: Add-Ons
Subgroup

Templates

Descriptions

EXSPI-60- Virus Scan Messages
Cleaned per Sec

EXSPI-60- Virus Scan Messages
Quarantined per Sec

EXSPI-60- Virus Scan Files Cleaned per
Sec

Checks Information Store Anti Virus API
of Messages Cleaned/Sec.

Checks Information Store Anti Virus API
of Messages Quarantined/sec

Checks Information Store Anti Virus API
of Files Cleaned/Sec.
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EXSPI-60 ADVANCED

Exchange 2000 and Templates Descriptions
2003: Advanced
Subgroups
EXSPI-60 End To End Templates in this group monitor email
Message Ping service responsiveness by sending an

EXSPI-60-1002

EXSPI-60-End to End Message Ping

email message from one Exchange server
to another

MSExchange End To End Message Ping
Monitor

30 m Scheduler for metric in End To End
Message Ping group

EXSPI-60 Event Log
Warnings and
Information

EXSPI-60-Exchange Application
Information

EXSPI-60-Exchange Application
Warnings

EXSPI-60-Exchange System
Information

EXSPI-60-Exchange System Warnings

Templates in this group collect all
Exchange-related warning and
information messages from the Windows
Event Log

Application Event Log - Notify All
Information

Application Event Log - Notify All
Warnings

Application Event Log - Notify All
Information

Application Event Log - Notify All
Warnings

EXSPI-60 Reporter
Collection

EXSPI-60-DC-Exchange Info
EXSPI-60-DC-Mailbox Data

EXSPI-60-DC-Mailbox IS Sum. Data
EXSPI-60-DC-Public Folder Data
EXSPI-60-DC-Public IS Sum. Data

EXSPI-60-DC-TrackLog Data

Templates in this group enable data
collections for OVO reports

Collect data on Exchange Parameters

Collect data about all mailboxes on the
system

Collect summary data about Mailbox
Information Store

Collect data about all public folders on
the system

Collect summary data about Public Info.
Store (Folders)

Collect Tracking.Log data
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Table of Exchange 5.5 templates

EXSPI-55 QUICK START

Exchange 5.5: Quick
Start Subgroups

Templates

Descriptions

EXSPI-55 Directory
Service

EXSPI-55-0110

EXSPI-55-0111

EXSPI-55-05m-DS

Templates in this group monitor directory
replication to verify that synchronization
updates are being processed efficiently.

MSExchangeDS.Remaining Replication
Synchronizations

MSExchangeDS.Remaining Replication
Updates

5m Scheduler for metrics in Directory
Service group

EXSPI-55-Event Log
Errors

EXSPI-55-Exchange Errors

Templates in this group monitor Exchange
error messages written to the Windows
Event log file and when detected, forwards
them to the OVO console

EXSPI-55 General Data
Collection

EXSPI-55-Dc-SMTP Message Volume

EXSPI-55-Measurement Data Collector

Templates in this group create data stores
and writes data to data stores

Collect data on the volume of SMTP
messages processed.

Forward single instance data to
Measurement Data Collector

EXSPI-55 Information
Store

EXSPI-55-0030
EXSPI-55-0031
EXSPI-55-0032
EXSPI-55-0033
EXSPI-55-0034
EXSPI-55-0040

Templates in this group collect data on the
volume of messages processed by both the
Private and Public Information Store
during the last logging interval

IS Public Average Delivery Time

IS Public Average Local Delivery Time
IS Public Replication Queue Size

IS Public Receive Queue Size

IS Public Send Queue Size

IS Mailbox Average Delivery Time
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Exchange 5.5: Quick Templates
Start Subgroups

Descriptions

EXSPI-55 Information | EXSPI-55-0041
Store (cont.)

EXSPI-55-0042
EXSPI-55-0043
EXSPI-55-0100
EXSPI-55-05m-IS

EXSPI-55-15m-IS
EXSPI-55-DC-IS Msg Delivery Time
EXSPI-55-DC-IS Private Msg Vol

EXSPI-55-DC-IS Public Msg Vol

IS Mailbox Average Local Delivery Time

IS Mailbox Receive Queue Size
IS Mailbox Send Queue Size
IS User Connection Count Low

5m Scheduler for metrics in Information
Store group

15m Scheduler for metrics in Information
Store group

Collect data on the average msg delivery
times in core processes

Collect data on the vol. of messages
processed by Private IS

Collect data on the vol. of messages
processed by Public IS

EXSPI-55 Internal
Errors

EXSPI-55-Messages

Templates in this group collect information
on errors occurring within the Exchange
SPI and contains instruction text for fixing
common problems

EXSPI-55 Message
Transfer Agent

EXSPI-55-0010
EXSPI-55-0011
EXSPI-55-0012
EXSPI-55-0013
EXSPI-55-0014
EXSPI-55-0015
EXSPI-55-0016

Templates in this group collect data on the
length of message queues and volume of
messages (number and kilobytes)
processed by the Message Transfer Agent.
Also collects data on failed, delayed, and
rejected inbound/outbound associations
and messages during the last logging
interval

MTA Message Delay

MTA Work Queue Length

MTA Failed Conversions

MTA Connection Message Delay
MTA Connection Queue Lengths
MTA Failed Outbound Associations
MTA Rejected Inbound Associations
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Exchange 5.5: Quick
Start Subgroups

Templates

Descriptions

EXSPI-55 Message
Transfer Agent (cont.)

EXSPI-55-0017

EXSPI-55-05m-MTA
EXSPI-55-1h-MTA
EXSPI-55-DC-MTA & IS Queue Len.

EXSPI-55-DC-MTA Message Volume

MTA Rejected Inbound Messages

5m Scheduler for metrics in MTA group
1h Scheduler for metrics in MTA group
Collect data on the length of message
queues in core processes

Collect data on the vol. of messages
processed by MTA

EXSPI-55 Services and
Processes

EXSPI-55-0001
EXSPI-55-0002
EXSPI-55-05m-Serv. & Processes

EXSPI-55-1001
EXSPI-55-10m-Serv. & Processes

EXSPI-55-DC-User Connections

Templates in this group monitor Windows
Services for Exchange by checking to see
that Exchange services configured with
Automatic startup are running.

Process Monitor
Inactive Process Monitor

5m Scheduler for metrics in Services and
Processes group

Process Monitor

10m Scheduler for metrics in Services
and Processes group

Collect data on the number of users

EXSPI-55 Transaction
Log

EXSPI-55-0005
EXSPI-55-0006
EXSPI-55-15m-Transaction Log

EXSPI-55-1d-Transaction Log

Templates in this group monitor the size
in MB of the Exchange transaction
logfiles as well as the disk space used by
the files.

15m Scheduler for metrics in Transaction
Log group

1day Scheduler for metrics in Transaction
Log group
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EXSPI-55 ADD-ONS

Subgroups

[Exchange 5.5: Add-Ons

Templates

Descriptions

Connector

EXSPI-55 CC:Mail

EXSPI-55-0090
EXSPI-55-0091
EXSPI-55-0092
EXSPI-55-0093
EXSPI-55-1h-ccMail Connector

EXSPI-55-5m-ccMail Connector

Templates in this group monitor the
number of messages awaiting delivery to
Exchange from Lotus cc:Mail, the rate at
which Non-Delivery Reports (NDRs) are
being sent from Lotus cc:Mail to
Exchange and vice versa

cc:Mail MTS-IN Queue Length
cc:Mail MTS-OUT Queue Length
Exchange NDRs to cc:Mail
cc:Mail NDRs to Exchange

1h Scheduler for metrics in cc:Mail
Connector group

5m Scheduler for metrics in cc:Mail
Connector group

Service

EXSPI-55 Internet Mail

EXSPI-55-0060

EXSPI-55-0061

EXSPI-55-0062
EXSPI-55-0063
EXSPI-55-0064
EXSPI-55-0065
EXSPI-55-0066

Templates in this group monitor the rate
SMTP connections to other hosts are
failing or being rejected for the Internet
Mail Service, the number of messages
queued to be converted to Internet Mail
format as well as the number awaiting
final delivery, the rate at which
non-delivery reports are being generated
for inbound mail and outbound mail

MSExchangeIMC.Connections Total
Failed MSExchangeIMC.Connections
Total Outbound

MSExchangeIMC.Connections Total
Rejected MSExchangeIMC.Connections
Total Inbound

MSExchangeIMC.Queued MTS-IN
MSExchangeIMC.Queued MTS-OUT
MSExchangeIMC.Queued Inbound
MSExchangeIMC.Queued Outbound

MSExchangeIMC.NDRs Total Inbound
MSExchangeIMC.Inbound Messages
Total
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[Exchange 5.5: Add-Ons
Subgroups

Templates

Descriptions

EXSPI-55 Internet Mail
Service (cont.)

EXSPI-55-0067

EXSPI-55-1h-Internet Mail Services
EXSPI-55-5m-Internet Mail Services
EXSPI-55-DC-IMS Message Volume

EXSPI-55-DC-IMS Queue Length

MSExchangeIMC.NDRs Total Outbound
MSExchangeIMC.Outbound Messages
TotalMSExchangeIMC.Outbound
Messages Total

1h Scheduler for metrics in Internet Mail
Services group

5 min. Scheduler for metrics in Internet
Mail Services group

Collect data on the vol. of messages
processed by the IMS

Collect data on the vol. of messages
processed by the IMS

EXSPI-55 Lotus Notes
Connector

EXSPI-55-0094

EXSPI-55-0095

EXSPI-55-0096
EXSPI-55-0097

EXSPI-55-1h-Lotus Notes Connect

EXSPI-55-5m-Lotus Notes Connect

Templates in this group monitor the
number of messages awaiting delivery,
and Non-Delivery Reports (NDRs) being
sent to Exchange from Lotus Notes and
vice versa

Lotus Notes Inbound Queued Messages
Length

Lotus Notes Outbound Queued Messages
Length

Exchange NDRs sent to Lotus Notes

Lotus Notes NDRs sent to Microsoft
Exchange

1h Scheduler for metrics in Lotus Notes
Connector group

5Sm Scheduler for metrics in Lotus Notes
Connector group

EXSPI-55 News Service

EXSPI-55-0080

EXSPI-55-0081

EXSPI-55-1h-News Service
EXSPI-55-DC-News Message Volume

Templates in this group monitor the rate
inbound and outbound newsfeed
messages are being rejected because of
duplicates or errors

1h Scheduler for News Service metrics

Collect data on the vol. of news messages
processed by IS
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Appendix B: Components
Table of Exchange 5.5 templates

EXSPI-55 ADVANCED

Exchange 5.5: Advanced Templates Descriptions
Subgroups
EXSPI-55 End To End Templates in this group monitor email
Message Ping service responsiveness by sending an

EXSPI-55-1002
EXSPI-55-End to End Message Ping

EXSPI-55 Ping Config

email message from one Exchange server
to another

MSExchange End To End Message Ping
Monitor

30 m Scheduler for metric in End To End
Message Ping group

EXSPI-55 Event Log
Warnings and
Information

EXSPI-55-Exchange Warnings

EXSPI-55-Exchange Information

Templates in this group collect all
Exchange-related warning and
information messages from the Windows
Event Log

Application Event Log - Notify All
Warnings

Application Event Log - Notify All
Information

EXSPI-55 Reporter
Collection

EXSPI-55-DC-Exchange Info
EXSPI-55-DC-Mailbox Data

EXSPI-55-DC-Private IS Sum. Data
EXSPI-55-DC-Public Folder Data
EXSPI-55-DC-Public IS Sum. Data

EXSPI-55-DC-TrackLog Data

Templates in this group enable data
collections for OVO reports

Collect data on Exchange Parameters

Collect data about all mailboxes on the
system

Collect summary data about Mailbox
Information Store

Collect data about all public folders on
the system

Collect summary data about Public Info.
Store (Folders)

Collect Tracking.Log data
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Index

This chapter provides an Index for the Exchange SPI Users Guide.
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A

actions
automatic in templates 7-154
operator initiated 7- 154
Administrative Groups folder
enable viewing 2-23
alarms, changing the threshold type for 7-151
applications
Disable Data Logging 1-11
Disable EXSPI Tracing 1-12
Enable Data Logging 1-11
Enable EXSPI Tracing 1-12
Enable Message Tracking 1-11
EXSPI Add DataSource 1-11
EXSPI Admin 1-11
EXSPI Discovery 1-11
EXSPI Graphs 1-11
EXSPI MBOX Config 1-11
EXSPI Node Config 1-12
EXSPI Ping Config 1-12

C

cluster environments, configuring Exchange SPI for 3-60,
5-108
clustered application configuration file 5-109
command files A-180
UNIX A-180
command line parameters 4-105
changing calculations for metrics 4-106
metric range 4-105
print 4-105
tag feature 4-105, 7-158
Component Interaction 1-5
component interaction B- 187
components
Message Group Bank
EX_Fault 4-87
EX_Perf 4-87
EXSPI 4-87
configuration
advanced 3-66
basic 3-56
mailboxes 3-71
Message Browser 3-59

Create User Account
(Ex2000&2003)/Windows 2000&2003) 2-41
(Ex5.5/NT4) 2-23
(Ex5.5/W2k) 2-31, 2-43
Crystal, report writer used with Service Reporter 6-125
customization
changing the Mailbox Name 7-159
changing the Windows User Account Name 7-159
choosing metrics to monitor 7-160
creating custom groupings 7-150
modifying metric conditions 7-151
modifying metric templates for all databases 7-151
of thresholds 7-155
schedules 7-156
using the tag feature 7-158

D

daily tasks 4-87
data collection
Add-Ons templates 6-129
Advanced templates 6-130
for graphing and reporting 6-125
Quick Start templates 6-125
dbspierror A-183
de-assigning Exchange SPI templates from managed nodes
3-82
deinstalling 6-146
deinstalling Exchange SPI 3-8 1
deleting Exchange SPI templates 3-83
disabling tracing 8-167
Discovery 1-11
rules in process 4-102
Domain Admin User with special Exchange privileges

E

Enable Data Logging
description of B-187
Enabling Message Tracking
Exchange 2000/2003 3-70
Exchange 5.5 3-68
enabling tracing 8-166
End-To-End Message Ping 3-66, 3-73
error log 8-165

Index
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errors
common 8-168

Exchange access permissions 3-66

Exchange Cluster Config 1-12

Exchange organization 1-5

Exchange Service Discovery Failures 8-174

Exchange SPI Discovery 1-6

Exchange SPI Service views 1-6

EXSPI Admin 1-11

EXSPI Node Config 3-67

exspi_e2k.exe/exspi_e55.exe A-179

exspi_le.sql A-178

exspicol.bat A-180

exspidsc.bat A-180

exspimwe.exe A-180

exspimwd.bat A-180

exspipv A-178

exspiset.idx A-177

exspispec A-181

exspitra.vbs A-180

F

files
command files A-180
on the management server A-177

G

Grant Exchange access permissions to User Account
for (Ex5.5/NT4) 2-28
for (Ex5.5/W2k) 2-39
graphing, using PerfView 6-145
graphs 1-16, 6-141
Information Store 6-142
Messaging 6-143
System Information 6-144
graphs, in PerfView Graph from a MW DSI logfile 6-145

H

high availability environments 5-108
HP ITO Account 2-21

I

installation 3-56
installing Exchange SPI report templates 6-119
on the management server 3-56
OVO agents on MS Exchange servers 3-57
prior to 3-53
verifying on management server 8-163
instruction text 1-4

L
logfile.dat A-177

M

managed node files A-179

exspierror A-183

logging and trace files A-183

monitor templates A-182

trace A-183

Windows A-182
management server files A-177, A-178

logfile.dat A-177

monitor.dat A-177

msggrps.dat A-177

msgi.dat A-177

schedule.dat A-177

set0.idx A-177

tmplgrp.dat A-177
management server/managed node files

monitor files A-179
management server/managed node monitor files

UNIX A-179
message text, modifying 7-154
message tracking

enable 3-66, 3-68

enabling on Exchange 2000 and 2003 servers 3-70
metric conditions, as contained in monitor templates 1-9
metrics

changing calculations for using command line param-

eter 4-106

showing values for, using -p parameter 4-105
monitor templates A-182
monitoring configuration file 5-108
msexchange.apm.xml 5-108, 5-109
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msexchange.apm.xml, modifying 5-108
msgi.dat A-177

0]

operator initiated actions, in templates 7-154
OVAMTLog.dll A-179

P

PerfView

graphing data with 6-145
PerfView graph 7-154
PerfView, using 6-145
Persistent store B-187
procedures

service accounts

creating in Windows2000/2003/Ex2000 or 2003
77-2-47

R

removing Exchange SPI software 3-8 1
report templates 6-146
reports 1-16
Exchange 2000/2003 list 6-134
Exchange 5.5 list 6-132, 6-137
requirements 6-120
reports/graphs
time interval required 6-138

S

schedule.dat A-177

server connections
setting up 3-73

service accounts
creating

Windows 2000 & 2003/Ex 2000 & 2003 ?7—2-47

service information

manual update 4-99

mechanism for gathering 1-6, 4-94
Service views 1-6, 4-100
severity setting in templates 7-154
swinstall, using to re-install templates 7-160

T

template failures
advanced configuration 8-172
templates
actions as defined in 7-154
advanced configuration template failures 8-172
assigning/distributing 3-67
customizing 4-93, 7-150
customizing message text 7-154
customizing thresholds in 7-153
distributing reporter collection templates 6-139
distributng Quick Start templates 6-138
duration interval, setting/resetting thresholds 7-154
duration settings 7-154
Exchange 200072003 list B-191
Exchange 5.5 list B-203
for opccfgupld (OVO upload facility) A-177
installation considerations 3-54
monitor templates 1-9
re-installing 7-160
Reporter Collection 6-139
schedule templates 1-9
severity alert setting 7-154
template group prerequisites for Exchange 2000 and
2003 4-91
template group prerequisites for Exchange 5.5 4-90
template groups requirements 4-89
template types 1-9
thresholds
changing 7-155
continuously (with no reset) 7-152
with reset 7-152
without reset 7-152
tmplgrp A-177
tmplgrp.dat A-177
trace files A-183
tracing
turning on 8-166
Troubleshooting 8-161
troubleshooting 8-174

U

user accounts with special Exchange access permissions,
how to create 2-22
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user privileges 2-21
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